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kenmerken van uw 
nieuwe MP3-speler
Mooi. Intelligent. Betrouwbaar. En vooral leuk! Dat is uw nieuwe MP3-speler, 
en nog veel meer. Dankzij de compacte vormgeving neemt deze MP3-speler 
slechts zeer weinig ruimte in. Daarnaast zorgt de geavanceerde technologie 
voor een rijk geluid en scherpe, levendige afbeeldingen en spelletjes met veel 
actie. U zult heel veel plezier beleven aan uw nieuwe MP3-speler, of u nu aan 
het sporten bent, uw favoriete nummers downloadt, video’s bekijkt, spelletjes 
speelt of gewoon naar de radio luistert.  Nadat u hem eenmaal hebt gebruikt, 
vraagt u zich af hoe u ooit zonder hebt gekund.

MEER MULTI IN MULTIMEDIA
We noemen het een MP3-speler, maar het 
is veel meer dan dat. U kunt afbeeldingen, 
tekst en video’s bekijken, naar FM-radio 
luisteren en spelletjes spelen.

AANRAAKBEDIENING
Door licht op het aanraakvlak te tikken kunt 
u door de menu's bladeren.

WAAR VORM EN FUNCTIONALITEIT 
HAND IN HAND GAAN
Jazeker, hij is gestroomlijnd en mooi. Maar 
hij ligt ook lekker in de hand en is eenvoudig 
te bedienen.

LANGERE AFSPEELDUUR EN KORTERE 
DOWNLOADTIJD
Met een volledig geladen batterij kan 
maximaal 25 uur muziek of 4 uur video 
worden afgespeeld.
Het downloaden gaat snel. Dankzij de 
compatibiliteit met USB 2.0 is de speler veel 
sneller dan modellen met USB 1.1.

WONDER VAN GELUIDSKWALITEIT
Uw nieuwe MP3-speler is uitgerust met 
DNSe™ (Digital Natural Sound-engine), 
de unieke geluidstechnologie van Samsung 
voor een rijker, dieper geluid en een 
ongelofelijke luisterbeleving.



veiligheidsinformatie
Betekenis van de pictogrammen en aanduidingen in 
deze gebruiksaanwijzing:

WAARSCHUWING

Risico van lichamelijk letsel met mogelijk fatale 
gevolgen.

LET OP
Risico van lichamelijk letsel of materiële schade.

LET OP

U kunt het risico op brand, ontploffi ng, elektrische 
schokken of lichamelijk letsel tijdens het gebruik van uw 
MP3-speler verminderen door de genoemde belangrijke 
voorzorgsmaatregelen in acht te nemen.

OPMERKING
Tips of verwijzingen naar informatie die u kunnen helpen 
bij het bedienen van de speler.

NIET proberen.

NIET demonteren.

NIET aanraken.

Volg de aanwijzingen nauwgezet op.

Haal de stekker uit het stopcontact.

Bel het servicecentrum voor assistentie.
Deze waarschuwingstekens dienen om persoonlijk letsel, van uzelf en van 
anderen, te voorkomen. Volg de aanwijzigen nauwgezet op.
Bewaar de gebruiksaanwijzing nadat u dit gedeelte hebt doorgelezen op 
een veilige plaats, zodat u deze informatie later nog eens kunt naslaan. 



veiligheidsinformatie
In deze gebruiksaanwijzing wordt het juiste gebruik van uw nieuwe 
MP3-speler beschreven. Lees de gebruiksaanwijzing zorgvuldig door 
om te voorkomen dat u de speler beschadigt of uzelf verwondt.
Let met name op de volgende serieuze waarschuwingen:

BESCHERM UZELF
Demonteer, repareer of wijzig het product niet zelf.

  Zorg dat het product niet nat wordt. Het product is niet waterbestendig. 
Als het product nat wordt, schakel het dan niet in. Anders zou u een 
elektrische schok kunnen krijgen. Neem in dat geval contact op met het 
dichtstbijzijnde Samsung Service Center.

 Gebruik het product niet tijdens een onweer met bliksem. Anders loopt u 
het risico op storingen of elektrische schok.

  Gebruik de oordopjes niet als u op een fi ets zit of een auto of motor 
bestuurt.
Dit kan een ernstig ongeluk veroorzaken. Het is bovendien in enkele landen bij wet 
verboden. Gebruik van de oortelefoon tijdens het lopen en joggen op de openbare 
weg, met name tijdens het oversteken, kan leiden tot ernstige ongelukken.

 Let er tijdens het sporten of wandelen omwille van de veiligheid op dat 
de kabel van de oortelefoon niet achter uw arm of een object in uw 
omgeving kan blijven haken.

 Plaats het product niet in een vochtige, stoffi ge of vuile omgeving. Anders 
zou brand kunnen ontstaan of loopt u het risico op een elektrische schok.

LET OP

WAARSCHUWING

LET OP



BESCHERM UZELF
 Het gebruik van oortelefoon of hoofdtelefoon gedurende langere tijd kan 
leiden tot ernstige gehoorbeschadiging.
Blootstelling voor langere tijd aan een geluidsniveau van meer dan 85 dB kan 
uw gehoor schaden. Hoe hoger het geluidsniveau, des te ernstiger de mogelijke 
gehoorschade. (Een normaal gesprek vindt plaats op een niveau van 50 tot 60 dB. 
Het geluidsniveau op de weg is ongeveer 80 dB.) U wordt uitdrukkelijk aanbevolen 
het volumeniveau op medium te zetten. (Medium is doorgaans minder dan 2/3 van 
het maximum.)
 Als u een piep in uw oren ervaart, moet u het volume verlagen of het 
gebruik van oortelefoon of hoofdtelefoon staken.

UW MP3-SPELER BESCHERMEN
 Bewaar of gebruik de speler niet bij temperaturen boven 35°C 
(bijvoorbeeld een sauna of in een geparkeerde auto).
 Zorg dat u de speler nergens tegen stoot en laat de speler niet vallen.
Plaats geen zware voorwerpen op de speler.
 Voorkom dat externe deeltjes of stof in het product komen.
Plaats het product niet in de buurt van magnetische objecten.
 Zorg dat u een reservekopie van belangrijke gegevens maakt. Samsung 
is niet aansprakelijk voor verlies van gegevens.
 Gebruik uitsluitend door Samsung geleverde of goedgekeurde accessoires.
 Spuit geen water op het product. Maak het product niet schoon met 
chemicaliën als benzeen of thinner. Hierdoor kan er brand ontstaan, kunt 
u een elektrische schok krijgen en kan het oppervlak beschadigd raken.
 Het niet opvolgen van deze instructies kan tot lichamelijk letsel leiden of 
schade aan de speler veroorzaken.
 Als u deze gebruiksaanwijzing wilt afdrukken, adviseren we u dat u deze 
in kleur afdrukt en de optie “Aan pagina aanpassen” in de afdrukopties 
selecteert voor een betere weergave. 

LET OP

OPMERKING

WAARSCHUWING

LET OP
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basisinformatie
INHOUD VAN DE VERPAKKING
Bij uw nieuwe MP3-speler worden de volgende accessoires geleverd. Als een 
van deze items ontbreekt, moet u contact opnemen met de klantenservice van 
Samsung.

Speler Oortelefoon

USB-kabel Installatie-cd

Het ontwerp van de accessoires kan ter verbetering van het product zonder 
voorafgaande kennisgeving worden gewijzigd.
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UW MP3-SPELER

Scherm

Toets Aan/uit en Vergrendelen

Schuiven en vasthouden in de 
tegenovergestelde richting van 
de pijl om het apparaat in of uit te 
schakelen. Schuiven in de richting 
van de pijl om de functietoetsen te 
vergrendelen.

Bevestiging nekkoord

Resetopening
Als er een storing in de speler 
optreedt, drukt u met een puntig 
voorwerp in de resetopening 
om het systeem opnieuw te 
initialiseren.
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UW MP3-SPELER (Vervolg)
Deze toetsen zijn aanraaktoetsen.

Toets Vorige
Hierop tikken om naar het vorige scherm 

te gaan. Iets langer indrukken om naar het 
scherm met het hoofdmenu te gaan.

Toets Volume omhoog
Hierop tikken om het volume te verhogen of om 
naar een bovenliggend item of menu te gaan..

Toets Afspelen/Onderbreken/
Selecteren

Hierop tikken om afspelen/onderbreken en 
functie te selecteren, naar het volgende 

scherm gaan

Linkertoets bestandsbrowser
Hierop tikken om naar het vorige nummer 

of menu te gaan of het huidige nummer 
vanaf het begin af te spelen.

Iets langer indrukken om snel langs de 
nummers te lopen

Toets Volume omlaag
Hierop tikken om het volume te verlagen of om 

naar een onderliggend item of menu te gaan.

Rechtertoets bestandsbrowser
Hierop tikken om naar het volgende nummer 

of menu te gaan. Iets langer indrukken om 
snel langs de nummers te lopen.

Toets Menu
Hierop tikken om het menu weer te geven
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UW MP3-SPELER (Vervolg)

Oortelefoon
Op het linkerdopje ziet u een “L” 
en op het rechterdopje een “R”. 

Fungeert tevens als antenne voor 
de FM-radio in de MP3-speler.

Oortelefoonstekker

USB-aansluiting
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SCHERMEN
Muziek

1 Indicator hoofdmenu

2
Vergrendeling / Alarm / 
Sluimerstandindicator

3 Batterijstatus

4
Indicator huidig nummer / 
totaal aantal nummers

5 Afspeelsnelheid

6 Huidige tijd

7 Totale afspeeltijd

8 Afspelen/pauze, zoeken

9 Indicator muziekmodus

10 Indicator afspeelmodus

11 Indicator DNSe-modus

12 Muziekafspeelscherm

13 Titel

14 Statusbalk afspelen

15 Huidige afspeeltijd

 De schermafbeeldingen dienen slechts ter illustratie. Het scherm kan er in 
werkelijkheid anders uitzien.OPMERKING

Music

  Rising Sun

02:13 04:28

15/20
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SCHERMEN (Vervolg)
Video

1
Vergrendeling / Alarm / 
Sluimerstandindicator 6 Indicator videomodus

2 Batterijstatus 7 Bestandsnaam

3 Huidige tijd 8 Statusbalk afspelen

4 Totale afspeeltijd 9 Huidige afspeeltijd

5 Afspelen/pauze, zoeken

Video Track 1

5

6

7

8

9

1

2

3

4
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SCHERMEN (Vervolg)
Afbeelding

1
Vergrendeling / Alarm / 
Sluimerstandindicator

2 Batterijstatus

3
Indicator huidig bestand / 
totaal aantal bestanden

4 Huidige tijd

5 Afspeelstatus muziek

6 Indicator Afbeeldingsmodus

7 Indicator hoofdmenu

8 Bestandsnaam

FM-radio
1 Huidige tijd

2 Batterijstatus

3
Vergrendeling / Alarm / 
Sluimerstandindicator

4 Indicator radiomodus

5 Handmatig/voorkeuze

6 Huidige frequentie (MHz)

7 Frequentielocatie

8 RDS-indicator

[Voorbeeldscherm]
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WERKEN MET HET AANRAAKVLAK
Tik met uw vingertop op het aanraakvlak.

 Gebruik alleen uw vingers voor de bediening van het apparaat. Om schade te 
voorkomen dient u geen andere objecten te gebruiken voor de bediening.
Tik niet op het aanraakvlak met vuile vingers.
Tik niet op het aanraakvlak met handschoenen aan.
 Het aanraakvlak werkt mogelijk niet goed als u bijvoorbeeld uw vingernagel of een 
balpen gebruikt.

OPMERKING
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DE BATTERIJ OPLADEN
Laad de speler op voordat u deze voor het eerst gebruikt en wanneer u deze 
lange tijd niet hebt gebruikt.
Het volledig opladen van de batterij van de MP3-speler duurt ongeveer 4 uur. 
De oplaadtijd kan echter variëren, afhankelijk van uw computeromgeving.

1. Sluit het grootste uiteinde van de USB-kabel aan op de USB-aansluiting aan 
de onderkant van de speler.

2. Sluit de USB-kabel aan op de USB-poort ( ) van de computer.

2

Schermweergave
Verbonden via USB

1
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ONDERHOUD VAN DE BATTERIJ
De batterij gaat langer mee als u de volgende eenvoudige aanwijzingen voor 
het gebruik en de opslag ervan opvolgt.
•   Opladen en bewaren bij een temperatuur tussen 5°C en 35°C.
• De batterij niet te lang opladen (niet langer 12 uur). 

Overmatig opladen of ontladen kan de levensduur van de batterij verkorten.
• Aangezien een batterij een verbruiksartikel is, neemt de levensduur van de 

batterij na verloop van tijd geleidelijk af.
 Als u de speler oplaadt door deze aan te sluiten op een draagbare computer, 
controleer dan eerst of de batterij van de draagbare computer zelf volledig is 
opgeladen of de draagbare computer is aangesloten op het lichtnet.
 De oplaadbare accu in dit product kan niet door de gebruiker zelf worden vervangen. 
Neem contact op met uw serviceprovider voor informatie over vervanging.

DE SPELER IN- EN UITSCHAKELEN
De speler inschakelen
Schuif en houd de  schakelaar ingedrukt in de 
tegenovergestelde richting van de pijl.

De speler wordt ingeschakeld.

De speler uitschakelen
Schuif en houd de  schakelaar nogmaals 
ingedrukt in de tegenovergestelde richting van de pijl.

De speler wordt uitgeschakeld.

 Het toestel wordt automatisch uitgeschakeld als gedurende een bepaalde tijd geen 
toetsen worden ingedrukt in de stopstand. De fabrieksinstelling voor <Auto Power 
Off> (Autom. uitschakelen) is 1 minuut, maar u kunt deze tijd zelf wijzigen. Zie 
pagina 29 voor meer informatie.

OPMERKING

OPMERKING

LET OP
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MUZIEK AFSPELEN
Laad muziekbestanden naar uw nieuwe MP3-speler met EmoDio.
Zie pagina 33-35 voor meer informatie over EmoDio.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toetsen [Links, Rechts] om <Music> (Muziek) te 

selecteren en tik vervolgens op [ ].
3. Gebruik de toetsen [Omhoog, Omlaag] en [ ] om het 

gewenste muziekbestand te selecteren.
4. Tik op [ ].

Het muziekbestand wordt afgespeeld.
 Tik op [ ] om naar het vorige scherm te gaan. 
 Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

HET VOLUME REGELEN
Tik op de toets [Omhoog, Omlaag].

Er wordt een volumesymbool weergegeven.
Het volumebereik is ingesteld van 0 tot 30.
 Tik op de toets [Omhoog] om het volume te verhogen en tik op 
de toets [Omlaag] om het volume te verlagen.

OPMERKING

Music

  Rising Sun

02:13 04:28

15/20

Music

  Rising Sun

02:13 04:28

15/20
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DE TOETSEN VERGRENDELEN
Met de vergrendelfunctie kunt u alle andere toetsen op de MP3-speler 
deactiveren, zodat uw muziek niet wordt onderbroken wanneer een van de 
toetsen, bijvoorbeeld tijdens het sporten, per ongeluk wordt ingedrukt.
1. Schuif de  schakelaar in de richting van de pijl.
2. Schuif de  schakelaar in de tegenovergestelde 

richting van de pijl om de vergrendelfunctie uit te schakelen.

BESTANDEN ZOEKEN MET “FILE 
BROWSER”
(BESTANDSBROWSER)
U kunt eenvoudig bestanden zoeken met de functie “File Browser” (Bestandsbrowser).
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toetsen [Links, Rechts] om <File Browser> 

(Bestandsbrowser) te selecteren en tik vervolgens op [ ].
 De map <File Browser> (Bestandsbrowser) wordt weergegeven, 
met daarin <“Music, Playlists, Video, Pictures, Datacasts, Texts 
en Recorded Files”> (muziek, afspeellijsten, video, afbeeldingen, 
datacasts, teksten en opgenomen bestanden).

3. Tik op de toets [Omhoog, Omlaag] om de gewenste map 
te selecteren.

4. Tik op [ ] om de lijst met bestanden in de geselecteerde 
map weer te geven.

Tik op [ ] om naar het vorige scherm te gaan.
5. Tik op de toets [Omhoog, Omlaag] om het gewenste bestand te selecteren.
6. Tik op [ ].

  Het bestand wordt afgespeeld.

Music

  Rising Sun

02:13 04:28

15/20
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BESTANDEN VERWIJDEREN MET “FILE BROWSER” 
(BESTANDSBROWSER)
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toetsen [Links, Rechts] om <File Browser> 

(Bestandsbrowser) te selecteren en tik vervolgens op [ ].
 De mappenlijst <File Browser> (Bestandsbrowser) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de gewenste map 
te selecteren en tik op [ ].

4. Tik op de toets [Omhoog, Omlaag] om het bestand te 
selecteren dat u wilt verwijderen, en tik op [ ].

5. Tik op de toets [Omhoog, Omlaag] om <Delete> (Wissen) te selecteren en 
tik op [ ].
Het bevestigingsvenster wordt weergegeven.

6.  Tik op de toets [Links, Rechts] om <Yes> (Ja) te selecteren en tik op [ ].
Het bestand wordt verwijderd.

Bestanden kunnen niet meer worden hersteld nadat ze zijn verwijderd.

File Browser

Music
Playlists
Video
Pictures
Datacasts
Texts
Recorded Files

LET OP
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INSTELLINGEN EN VOORKEUREN WIJZIGEN
De instellingen en voorkeuren van de MP3-speler zijn in de fabriek ingesteld, 
maar u kunt deze voorgeprogrammeerde waarden zelf aan uw persoonlijke 
voorkeuren aanpassen.

 Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

Instellingen voor menustijl
U kunt het uiterlijk van het menu wijzigen en de achtergrondafbeelding 
van het hoofdmenu verwijderen.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op toets [Links, Rechts] om <Settings> 

(Instellingen) te selecteren en tik vervolgens op [ ].
 Het menu <Settings> (Instellingen) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <Menu 
Style> (Menustijl) te selecteren en tik op [ ].

 Het menu <Menu Style> (Menustijl) wordt weergegeven.
4. Gebruik de toetsen [Omhoog, Omlaag] en [ ] 

om de functies in te stellen.
Tik op [ ] om naar het volgende item te gaan of het menu te selecteren. 
 Tik op de toets [Omhoog, Omlaag] om in het huidige menu te bladeren.

Instellingsopties voor menustijl
 Menu Design (Menuontwerp) : U kunt de stijl van het hoofdmenu wijzigen. Maak 
een keuze uit <Sparkling> (Sprankelend), <Crystal> (Kristal), <My Skin> (Mijn huid). 
 Font (Lettertype) : U kunt het lettertype van de menutaal wijzigen. Kies één van de 
drie lettertypes. Voor sommige talen is de optie <Font> (Lettertype) uitgeschakeld.
 Reset My Skin (Mijn Skin opnieuw instellen) : Stelt de achtergrondafbeelding 
van het aanraakscherm in op de standaardafbeelding. Als u in <Menu Design> 
(Menuontwerp) de optie <Sparkling> (Sprankelend) of <Crystal> (Kristal) instelt, 
wordt de functie <Reset My Skin> (Mijn Skin opnieuw instellen) uitgeschakeld.

OPMERKING

Settings

Menu Style
Sound
Display
Language
Time 
System
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Geluidsinstellingen
U kunt de hoofd-EQ, de pieptoon en de volumegrens instellen.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Links, Rechts] om <Settings> 

(Instellingen) te selecteren en tik vervolgens op [ ].
 Het menu <Settings> (Instellingen) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <Sound> 
(Geluid) te selecteren en tik op [ ].

Het menu <Sound> (Geluid) wordt weergegeven.

4. Gebruik de toetsen [Omhoog, Omlaag] en [ ] om de functies in te 
stellen.

Opties voor geluidsinstellingen
 Master EQ (Hoofd-EQ) : U kunt de geluidsinstellingen optimaliseren. 
Tik op de toets [Links, Rechts] om de frequentie te selecteren die u wilt 
aanpassen. Tik op de toets [Omhoog, Omlaag] om het niveau van de 
geselecteerde frequentie aan te passen en tik op [ ].
 Beep Sound (Piepgeluid) : Het geluidssignaal voor de bediening van het 
aanraakscherm inschakelen of uitschakelen. U kunt kiezen tussen <Off> (UIT) 
en <On> (AAN).
 Volume Limit (Volume grens): U kunt gehoorbeschadiging bij gebruik van de 
koptelefoon voorkomen door een volumegrens in te stellen. Als de volumegrens 
is ingeschakeld, is het maximumvolume 15. 
Als de volumegrens is uitgeschakeld, is het maximumvolume 30.
Als u <Off> (UIT) selecteert, wordt het volume teruggezet naar 15 om schade 
aan uw gehoor te voorkomen wanneer u de speler weer inschakelt.

Settings

Menu Style
Sound
Display
Language
Time 
System
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Weergave-instellingen
De uitschakeltijd, screensaver en helderheid van uw scherm wijzigen.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Links, Rechts] om <Settings> 

(Instellingen) te selecteren en tik vervolgens op [ ].
 Het menu <Settings> (Instellingen) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <Display> 
(Weergave) te selecteren en tik op [ ].

Het menu <Display> (Weergave) wordt weergegeven.

4. Gebruik de toetsen [Omhoog, Omlaag] en [ ] om de functies in te 
stellen.

Opties voor weergave-instellingen
 Display Off (Display Uit) : Als geen wachttijd is ingesteld, wordt het scherm 
automatisch uitgeschakeld. U kunt kiezen uit <15sec>, <30sec>, <1min>, 
<3min>, <5min> en <Always On> (Altijd aan). U kunt het scherm weer 
inschakelen door op een willekeurige toets te drukken. 
 Screen Saver (Screensaver) : U kunt een afbeelding instellen voor het 
screensaver-scherm. Selecteer <Auto Change> (Automatisch wijzigen), 
<Sweet> (Lief), <Blue Rain> (Melancholie en regen), <Cheers> (Proost), 
<Analog Clock> (Analoge klok), <Digital Clock> (Digitale klok) en stel de 
wachttijd in. U kunt kiezen uit <Off> (UIT), <15sec>, <30sec>, <1min>, 
<3min> en <5min>. Als geen tijd is geselecteerd, wordt de screensaver-foto 
weergegeven. U kunt de screensaver-afbeelding wijzigen door op [ ] te tikken 
terwijl deze wordt uitgevoerd.
 Brightness (Helderheid) : U kunt de helderheid van het scherm instellen.Kies 
een niveau van <0-10>, met 10 als meest helder.
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Taalinstellingen
De menu’s van de MP3-speler kunnen worden ingesteld om in diverse talen 
te worden weergegeven. U kunt uw voorkeurstaal eenvoudig instellen.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Links, Rechts] om <Settings> 

(Instellingen) te selecteren en tik vervolgens op [ ].
 Het menu <Settings> (Instellingen) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om 
<Language> (Taal) te selecteren en tik op [ ].

Het menu <Language> (Taal) wordt weergegeven.
4. Gebruik de toetsen [Omhoog, Omlaag] en [ ] 

om de functies in te stellen.
Opties voor taalinstellingen

 Menu : De menutaal instellen. U kunt kiezen uit <English>, <한국어>, 
<Français>, <Deutsch>, <Italiano>, <日本語>, <简体中文>, <繁體中文>, 
<Español>, <Русский>, <Magyar>, <Nederlands>, <Polski>, <Português>, 
<Svenska>, <ไทย>, <Čeština>, <Ελληνικά>, <Türkçe>, <Norsk>, <Dansk>, 
<Suomi>, <Español (Sudamérica)>, <Português (Brasil)>, <Indonesia>, <Tiếng 
Việt>, <Bulgarian>, <Română>, <Українська>, <Slovenščina> of <Slovenský>.
 Contents (Inhoud) : De taal instellen waarin de nummergegevens en tekst worden 
weergegeven. U kunt kiezen uit <English>, <Korean>, <French>, <German>, 
<Italian>, <Japanese>, <Simplifi ed Chinese>, <Tranditional Chinese>, <Spanish>, 
<Russian>, <Hungarian>, <Dutch>, <Polish>, <Portuguese>, <Swedish>, <Thai>, 
<Finnish>, <Danish>, <Norwegian>, <Farsi>, <Afrikaans>, <Basque>, <Catalan>, 
<Czech>, <Estonian>, <Greek>, <Hrvatski>, <Icelandic>, <Rumanian>, <Slovak>, 
<Slovene>, <Turkish> of <Vietnamese>.

De ondersteunde talen kunnen worden gewijzigd of toegevoegd.
OPMERKING
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Tijdinstellingen
Door de tijd in te stellen kunt u de ingestelde datum/tijd, het datumtype 
en zelfs de tijdzone gebruiken.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Links, Rechts] om <Settings> 

(Instellingen) te selecteren en tik vervolgens op [ ].
 Het menu <Settings> (Instellingen) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <Time> 
(Tijd) te selecteren en tik op [ ].

Het menu <Time> (Tijd) wordt weergegeven.

4. Gebruik de toetsen [Omhoog, Omlaag] en [ ] om de functies in te 
stellen.

Opties voor Tijdinstellingen
 Date&Time (Datum en tijd) : U kunt de huidige datum en tijd instellen. Tik op 
[Links, Rechts] om naar <Year, Month, Date, Hour, Min, AM/PM> (Jaar, Maand, 
Dag, Uur, Min, AM/PM) te gaan en tik vervolgens op [Omhoog, Omlaag] om elk 
item in te stellen.
 Date Type (Datumtype) : U kunt het type tijdweergave voor de wereldklok 
instellen. U kunt kiezen uit <YY-MM-DD>(JJ-MM-DD), <MM-DD-YY>(MM-DD-
JJ) en <DD-MM-YY>(DD-MM-JJ).
 Time Zone (Tijdzone) : U kunt de huidige tijd wijzigen door een internationale 
tijdzone te selecteren. U moet de tijdzone instellen voordat de wereldtijd kan 
worden weergegeven. Zie pagina 85.
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Systeeminstellingen
Kies de instellingen voor de sluimerfunctie en automatisch uitschakelen 
die bij u passen.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Links, Rechts] om <Settings> 

(Instellingen) te selecteren en tik vervolgens op [ ].
 Het menu <Settings> (Instellingen) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om 
<System> (Systeem) te selecteren en tik op [ ].

Het menu <System> (Systeem) wordt weergegeven.

4. Gebruik de toetsen [Omhoog, Omlaag] en [ ] om de functies in te 
stellen.

Settings

Menu Style
Sound
Display
Language
Time 
System



basisinformatie _ 29

INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Opties voor systeeminstellingen

 Sleep (Standby) : Het apparaat wordt na de opgegeven tijd automatisch uitgeschakeld. 
U kunt kiezen uit <Off> (UIT), <15 min >, <30min>, <60min>, <90min> en <120min>.
 Start Mode (Startmodus) : U kunt instellen dat het startscherm wordt weergegeven 
als u de speler inschakelt. U kunt kiezen uit <Home> (Start) en <Last State>(Vorige 
status). Kies <Home> (Start) om het systeem op te starten in het hoofdmenu of <Last 
State> (Vorige status) om op te starten in het laatst gebruikte menuscherm.
 Auto Power Off (Autom. uitschakelen) : De speler wordt automatisch uitgeschakeld 
als het afspelen is onderbroken en er gedurende de opgegeven tijd geen toetsen 
worden ingedrukt. U kunt kiezen uit <15sec>, <30sec>, <1min>, <3min>, <5min> of 
<Always On> (Altijd aan).
 Default Set (Standaard instellen) : De standaardwaarden voor alle instellingen 
worden hersteld. U kunt kiezen uit <Yes> (Ja) en <No> (Nee). Met <Yes> (Ja) zet 
u alle instellingen terug naar de beginwaarden. Met <No> (Nee) annuleert u het 
herstellen van de standaardinstellingen.
 Format (Formatteren) : Het interne geheugen formatteren. U kunt kiezen uit <Yes> 
(Ja) en <No> (Nee). Als u <Yes> (Ja) kiest, wordt het interne geheugen geformatteerd 
en worden alle bestanden op de speler gewist. Als u <No> (Nee) selecteert, wordt het 
interne geheugen niet geformatteerd. Controleer voordat u gaat formatteren of alle 
bestanden gewist mogen worden.
 About (Info) : De fi rmwareversie en geheugencapaciteit controleren. 
Met <Firmware Version> (Firmwareversie) wordt de huidige versie van de fi rmware 
weergegeven. <Used> (Gebruikt) geeft het gebruikte geheugen aan, <Available> 
(Besch.) geeft het resterende geheugen aan en <Total> (Totaal) staat voor de totale 
geheugencapaciteit.

 Het ingebouwde geheugen
1GB=1.000.000.000 bytes : de werkelijke, geformatteerde capaciteit is 
mogelijk minder omdat een gedeelte van het geheugen wordt gebruikt door 
de interne fi rmware.

OPMERKING
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DE MP3-SPELER RESETTEN
Als uw MP3-speler niet start, geen muziek wil afspelen of niet wordt herkend 
door uw computer wanneer u deze aansluit, is het misschien nodig het systeem 
te resetten.

Druk met een puntig voorwerp, zoals een 
veiligheidsspeld, aan de onderzijde van het 
product de Resetopening in.

Het systeem wordt geïnitialiseerd.
 Met de Reset-functie worden geen 
tijdgegevens en gegevens in het ingebouwde 
geheugen verwijderd.
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EmoDio
EmoDio is een gebruiksvriendelijke softwaretoepassing voor het ordenen 
van bestanden op uw computer. Nadat uw bestanden zijn geordend in 
EmoDio, kunt u de bestanden in een handomdraai overzetten naar uw 
MP3-speler, zonder dat u de hele vaste schijf hoeft te doorzoeken voor 
het juiste bestand.

SYSTEEMVEREISTEN
Uw computersysteem moet minimaal voldoen aan de volgende specifi caties om 
EmoDio te installeren en gebruiken:

Pentium 500MHz of hoger
USB 2.0-poort
Windows XP Service Pack 2 of hoger
DirectX 9.0 of hoger
100 MB vrije schijfruimte
Cd-romstation (2x of hoger)
Windows Media Player 10.0 of hoger
Resolutie 1024 X 768 of hoger
Internet Explorer 6.0 of hoger
512 MB RAM of hoger

•
•
•
•
•
•
•
•
•
•
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EMODIO INSTALLEREN
 Voer het installatieprogramma van <EmoDio> uit via de beheerdersaccount op uw 
computer. Anders wordt <EmoDio> niet geïnstalleerd. Meer informatie over het 
gebruik van de beheerdersaccount vindt u in de handleiding van uw computer.

1. Plaats de installatie-cd die bij de speler is 
geleverd in het cd-romstation.

2. Klik op <Install now> (Nu installeren).
Volg de instructies om de installatie te starten.
 De installatie van <EmoDio> wordt gestartWanneer de installatie is voltooid, verschijnt 
het pictogram  op uw bureaublad.

 Wees voorzichtig bij het plaatsen en uitnemen van de installatie-cd als uw cd-rom-
station verticaal is geïnstalleerd.LET OP

LET OP
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BESTANDEN OVERBRENGEN NAAR DE SPELER MET 
EMODIO
Met <EmoDio> kunt u bestanden en mappen selecteren en ordenen voordat u 
deze overbrengt naar de speler. Het opzoeken van bestanden op uw MP3-
speler wordt hierdoor versneld en vereenvoudigd. <EmoDio> biedt de handigste 
manier om uw bestanden van uw computer over te zetten naar uw MP3-speler.

1. Sluit het grootste uiteinde van de USB-kabel aan op de USB-aansluiting aan 
de onderkant van de speler.

2. Sluit de USB-kabel aan op de USB-poort ( ) van de computer.
 Op het aanraakscherm van de speler wordt <USB connected>(USB aangesloten) 
weergegeven.
 <EmoDio> wordt automatisch gestart op het moment dat de speler wordt aangesloten 
op de computer.
 Als het programma niet automatisch wordt gestart, dubbelklikt u op het pictogram  
van <EmoDio> op het bureaublad.

 De technologie voor het herkennen van muziek en verwante gegevens wordt 
geleverd door Gracenote en Gracenote CDDB® Music Recognition ServiceSM.
 CDDB is een gedeponeerd handelsmerk van Gracenote. Het logotype en logo 
van Gracenote, Gracenote CDDB en het logo “Powered by Gracenote CDDB” zijn 
gedeponeerde handelsmerken van Gracenote. Music Recognition Service en MRS 
zijn servicemerken van Gracenote.

1
2

OPMERKING
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BESTANDEN OVERBRENGEN NAAR DE SPELER MET 
EMODIO (Vervolg)
3. Klik op het pictogram voor het type bestand dat 

u wilt overbrengen.
Klik op  om de muzieklijst weer te geven.
Klik op  om de videolijst weer te geven.
Klik op  om de afbeeldingenlijst weer te geven.

4. Klik op <Add File> (Bestand toevoegen) onder 
aan in <EmoDio>.

Het venster <Open> (Openen) wordt weergegeven.

5. Selecteer de bestanden die u wilt toevoegen en 
klik op <Open> (Openen).

  De bestanden worden aan de lijst aan de linkerzijde 
van het scherm <EmoDio> toegevoegd.

6. Selecteer het bestand dat u wilt overzetten in de 
lijst aan de linkerkant.

7. Klik op het pictogram  .
 Het geselecteerde bestand wordt overgebracht naar 
de speler.

5

4

3

76
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BESTANDEN OVERBRENGEN NAAR DE SPELER MET 
EMODIO (Vervolg)

 Koppel de USB-kabel niet los tijdens de bestandsoverdracht. Loskoppelen van 
de USB-connector tijdens bestandsoverdracht kan leiden tot beschadiging van de 
speler en de computer.
 Sluit de speler rechtstreeks op de computer aan in plaats van via een USB-hub. 
Zo voorkomt u een instabiele verbinding.

  Wanneer u een videobestand naar de speler overbrengt met <EmoDio>, wordt het 
bestand vóór de overdracht geconverteerd naar de indeling SVI. Tevens wordt de 
bestandsgrootte aangepast.  
  Wanneer u een afbeelding naar de speler overbrengt met <EmoDio>, wordt het 
bestand vóór de overdracht geconverteerd naar JPG-indeling. Tevens wordt de 
bestandsgrootte aangepast.
Zolang de speler is aangesloten op de computer, zijn alle functies uitgeschakeld.
 Als u de USB-kabel op de computer aansluit terwijl de batterij bijna leeg is, wordt de 
speler eerst enkele minuten opgeladen voordat de verbinding met de computer tot 
stand wordt gebracht.
 U kunt het beste FAT 32 voor het bestandssysteem gebruiken wanneer u de speler 
op uw computer formatteert.
 EmoDio heef een uitgebreide Help-functie. Als u het antwoord op uw vraag over 
EmoDio hier niet kunt vinden, klikt u op <MENU> → <Help> → <Help> aan de 
bovenkant van het venster van <EmoDio>.
 Wat is SVI?
Samsung Audio Video Interleaving (SVI) is een nieuwe video-indeling, ontwikkeld 
door en in beheer bij Samsung.

LET OP

OPMERKING
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muziek beluisteren
 Voordat u begint! -  De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.
 Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

LUISTEREN OP CATEGORIE

1. Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.
2. Tik op de toets [Links, Rechts] om <Music> (Muziek) te selecteren en tik 

vervolgens op [ ].
De <Music> (Muziek) lijst wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de gewenste lijst te selecteren en tik 
op [ ].

Het muziekbestand wordt weergegeven.

4. Tik op de toets [Omhoog, Omlaag] om het bestand te selecteren dat wilt 
afspelen en tik op [ ].

De muziek wordt afgespeeld.

OPMERKING
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LUISTEREN OP CATEGORIE (Vervolg)

Muzieklijst
Bestandsinformatie, waaronder naam van de artiest, naam van het album, titel van het 
nummer en het genre worden weergegeven, gebaseerd op de ID3-taginformatie bij 
het muziekbestand. Bestanden zonder ID3-Tag worden weergegeven als <Unknown> 
(Onbekend).

Now Playing (Nu Speelt) : Speelt een recent afgespeeld bestand of gaat naar het 
afspeelscherm van het huidige bestand.
Artists (Artiest) : Afspelen op artiest
Albums (Album) : Afspelen op album
Songs (Nummers) : Afspelen in numerieke of alfabetische volgorde
Genres (Genre) : Afspelen op genre 
Playlists : Afspelen op afspeellijst
Recorded Files (Opgenomen Bestanden) : Toont alle opgenomen bestanden.
Music Browser (Muziekbrowser) : Geeft alle muziekbestanden in de muziekmap weer.

  De speler kan MP3- en WMA-muziekbestanden afspelen.
 MP1- of MP2-bestanden waarvan alleen de extensie is gewijzigd in MP3, kunnen 
niet worden afgespeeld op de speler.
 Als u tijdens het afspelen van muziek de koptelefoon loskoppelt, zal de muziek 
worden gepauzeerd.
 Wat is een ID3-taginformatie?
Dit is een tag in een MP3-bestand die informatie bevat over het bestand, zoals de 
titel, de artiest, het album, het jaar, het genre en een veld voor opmerkingen. 

OPMERKING
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PAUZEREN
1. Tik op [ ] terwijl de muziek wordt afgespeeld.

Het afspelen van de muziek wordt onderbroken.

2. Tik nogmaals op [ ].
De muziek wordt afgespeeld vanaf het punt waar het afspelen is gestopt.

ZOEKEN BINNEN EEN NUMMER
1. Houd de toets [Links, Rechts] enige tijd ingedrukt terwijl het geselecteerde 

nummer wordt afgespeeld.
Er wordt gezocht richting het begin of het einde van het nummer.

2. Laat de toets los op het punt waar u wilt starten.
Het nummer wordt afgespeeld vanaf het moment dat u de toets loslaat.

AFSPELEN VANAF HET BEGIN VAN HET HUIDIGE NUMMER
1. Tik na 3 seconden afspelen op de toets [Links].

Het huidige nummer wordt afgespeeld vanaf het begin.

HET VORIGE NUMMER AFSPELEN
Tik binnen 3 seconden afspelen op de toets [Links].
Tik na 3 seconden afspelen tweemaalop de toets [Links].

Het vorige nummer wordt afgespeeld.

HET VOLGENDE NUMMER AFSPELEN
Tik op de toets [Rechts].

Het volgende nummer wordt afgespeeld.

 Wanneer u VBR-bestanden afspeelt, wordt het vorige nummer mogelijk niet 
afgespeeld, ook al tikt u binnen 3 seconden op de toets [Rechts].LET OP
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EEN AFSPEELLIJST MAKEN MET EMODIO
Met <EmoDio> kunt u uw eigen collectie of afspeellijst met geluidsbestanden 
samenstellen.

Voordat u begint! -  Sluit de speler aan op de computer.
EmoDio moet zijn geïnstalleerd op de computer.

Een afspeellijst maken

1. Klik op <Playlists> (Afspeellijsten) boven in <EmoDio>.
Het venster <Playlists> wordt weergegeven.

2. Klik onder in het venster op <New Playlists>.
Het venster <Create Playlists> wordt weergegeven.

3. Geef een titel voor de afspeellijst op en klik op <OK>.
 De nieuwe afspeellijst krijgt een naam en wordt opgeslagen in het gedeelte 
<Playlists> (Afspeellijsten) in <EmoDio>.

2

1

OK 3
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EEN AFSPEELLIJST MAKEN MET EMODIO (Vervolg)
Muziekbestanden toevoegen aan een afspeellijst die u 
hebt gemaakt

1. Klik op <My PC> (Mijn PC) boven in <EmoDio>.
Het venster <My PC> (Mijn PC) wordt weergegeven.

2. Klik op <Playlists> in de rechterhoek van het venster.
Het venster <Playlists> wordt weergegeven.

3. Dubbelklik op een afspeellijst in het rechtervenster.
4. Selecteer in het venster <My PC> (Mijn PC) de bestanden die u wilt 

overbrengen.
5. Klik op het symbool .

 De geselecteerde bestanden worden aan de afspeellijst toegevoegd.

5

1

4 
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2
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EEN AFSPEELLIJST MAKEN MET EMODIO (Vervolg)

Een afspeellijst naar de speler overbrengen met EmoDio

1. Klik op <Playlists> (Afspeellijsten) boven in <EmoDio>.
Het venster <Playlists> wordt weergegeven.

2. Selecteer een afspeellijst in het gedeelte <Playlists>.
3. Klik op het symbool .

 De geselecteerde afspeellijst wordt overgezet naar <File Browser> 
(Bestandsbrowser) → <Playlists> (Afspeellijst).

De speler kan per afspeellijst tot 999 muziekbestanden afspelen.
OPMERKING
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EEN AFSPEELLIJST OP UW MP3-SPELER MAKEN
Als u al bestanden hebt gedownload naar uw MP3-speler, kunt u een afspeellijst 
met ‘Favorieten’ samenstellen zonder de hulp van EmoDio of uw computer.

1. Houd [ ] ingedrukt om naar het scherm met het 
hoofdmenu te gaan.

2. Tik op de toetsen [Links, Rechts] om <File Browser> 
(Bestandsbrowser) te selecteren en tik vervolgens op [ ].

3. Tik op de toets [Omhoog, Omlaag] om <Music> (Muziek) 
te selecteren en tik op [ ].

De muziekbestanden worden weergegeven.

4. Tik op de toets [Omhoog, Omlaag] om het bestand te 
selecteren dat u aan de afspeellijst wilt toevoegen, en tik 
op [ ].

Het menu Afspeellijst wordt weergegeven.

5. Tik op de toets [Omhoog, Omlaag] om <Add to Playlist> 
(Toev. aan afsp.) te selecteren en tik op [ ].

 <Playlist 1>(Afspeellijst 1) tot en met <Playlist 5>(Afspeellijst 5) 
wordt weergegeven.

6. Tik op de toets [Omhoog, Omlaag] om het nummer van 
de afspeellijst te selecteren waaraan u het geselecteerde 
bestand wilt toevoegen, en tik op [ ].

 Het geselecteerde bestand wordt aan de afspeellijst toegevoegd. 
 U kunt de afspeellijst bekijken via <Music>(Muziek) → <Playlists> → <Playlist 
1>(Afspeellijst 1) tot en met <Playlist 5> (Afspeellijst 5) in het hoofdmenu.

 U kunt maximaal 100 muziekbestanden toevoegen aan elke afspeellijst (Playlist 1 
<Afspeellijst 1> tot en met Playlist 5 <Afspeellijst 5>).OPMERKING
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EEN AFSPEELLIJST AFSPELEN
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan. 
2. Tik op de toets [Links, Rechts] om <Music> (Muziek) te 

selecteren en tik vervolgens op [ ].
De lijst <Music> (Muziek) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <Playlists> te 
selecteren en tik op [ ].

De afspeellijsten worden weergegeven.

4. Tik op de toets [Omhoog, Omlaag] om de gewenste 
afspeellijst te selecteren en tik op [ ].

 De muziekbestanden die in de geselecteerde afspeellijst zijn 
opgeslagen, worden weergegeven.
 Als geen afspeellijst wordt gevonden, wordt de melding 
<No File> (Geen bestanden.) op het scherm weergegeven.

5. Tik op de toets [Omhoog, Omlaag] om het bestand te 
selecteren dat wilt afspelen, en tik op [ ].

Het muziekbestand wordt afgespeeld.

  Zie pagina’s 39 en 41 voor meer informatie over hoe u een 
afspeellijst overbrengt met <EmoDio>.OPMERKING
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EEN BESTAND VERWIJDEREN UIT DE AFSPEELLIJST
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Links, Rechts] om <Music> (Muziek) te 

selecteren en tik vervolgens op [ ].
De muzieklijst wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <Playlists> te 
selecteren en tik op [ ].

De afspeellijsten worden weergegeven.
4. Tik op de toets [Omhoog, Omlaag] om de gewenste 

afspeellijst te selecteren en tik op [ ].
 De muziekbestanden die in de geselecteerde afspeellijst zijn 
opgeslagen, worden weergegeven.

5. Tik op de toets [Omhoog, Omlaag] om het bestand te selecteren dat u uit de 
afspeellijst wilt verwijderen, en tik op [ ].

Het menu Afspeellijst wordt weergegeven.
6. Tik op de toets [Omhoog, Omlaag] om <Delete from Playlist> (Verw. uit 

afspeellijst) te selecteren en tik op [ ].
Het bevestigingsvenster voor verwijderen wordt weergegeven.

7. Tik op de toets [Links, Rechts] om <Yes> (Ja) te selecteren en tik op [ ].
Het geselecteerde bestand wordt verwijderd uit de afspeellijst.

ALLE BESTANDEN VERWIJDEREN UIT DE AFSPEELLIJST
Volg stap 1 tot en met 4 hierboven.
5. Tik op [ ].

Het afspeellijstmenu wordt getoond.
6. Tik op de toets [Omhoog, Omlaag] om <Delete All from 

Playlist> (Alles verw. uit afsp.lijst) te selecteren en tik op 
[ ].

Het bevestigingsvenster voor verwijderen wordt weergegeven.
7. Tik op de toets [Links, Rechts] om <Yes> (Ja) te 

selecteren en tik op [ ].
Alle bestanden worden uit de afspeellijst verwijderd.
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HET MUZIEKMENU GEBRUIKEN
Via het menu Muziek heeft u controle over alle facetten van het luisteren 
naar muziek; van het herhalen van nummers en albums tot het kiezen van de 
schermachtergrond tijdens het afspelen van muziek.

Het geluidseffect instellen
U kunt genieten van helderder geluid.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Sound 
Effect> (Geluidseffect) te selecteren en tik op [ ].

 Het menu <Sound Effect> (Geluidseffect) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de 
gewenste geluidseffect te selecteren en tik op [ ].

Opties voor geluidseffecten
 Street Mode (Straatmodus) : In deze modus kunt u ook buiten luisteren naar 
muziek met een helder geluid, doordat straatgeluiden gefi lterd worden. U kunt 
kiezen uit <Off>(UIT) en <On>(AAN).
Clarity (Helderheid) : Geniet van een helderder geluid met verbeterde kwaliteit. 
Kies uit <0-2>.

Tik op [ ] om het menu te verlaten.
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De Digital Natural Sound-engine (DNSe) instellen (DNSe)
Hier selecteert u de juiste geluidsweergave voor elk muziekgenre.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <DNSe> 
te selecteren en tik op [ ].

Het menu <DNSe> wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de 
gewenste DNSe te selecteren en tik op [ ].

 U kunt kiezen uit <Normal> (Normaal), <Rock>, 
<Vocal> (Vocaal), <Bass Boost> (Bas Boost), 
<Classical> (Klassiek), <Studio>, <Concert Hall> (Concertzaal), en <User> 
(Gebruiker).
 U kunt <EQ> en <3D & BASS> (3D en bas) instellen als u <User> 
(Gebruiker) hebt geselecteerd. Zie pagina 47.

 Wat is DNSe?
Digital Natural Sound Engine (DNSe) is een functie voor geluidseffecten 
voor MP3-spelers die is ontwikkeld door Samsung. Dit biedt verschillende 
geluidsinstellingen voor het verbeteren van het type muziek waar u naar 
luistert.

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De Digital Natural Sound-engine (DNSe) instellen (Vervolg)
<EQ>
U kunt de individuele geluidsfrequenties naar wens instellen.
1 Tik op de toets [Omhoog, Omlaag] in het menu 

DNSe menu om <User> (Gebruiker) te selecteren 
en tik op de toets [Rechts].

2. Tik op de toets [Omhoog, Omlaag] om <EQ> 
(Equalizer) te selecteren en tik op [ ].

 Het instellingenscherm <EQ> wordt weergegeven.
3. Tik op de toets [Links, Rechts] om de frequentie 

te selecteren die u wilt aanpassen, en tik op de 
toets [Omhoog, Omlaag] om het niveau van de 
geselecteerde frequentie aan te passen.

 U kunt kiezen uit <–10 - +10> voor het niveau van de geselecteerde frequentie.
4. Tik op [ ].

De instelling is voltooid.
<3D & BASS> (3D en bas)
U kunt het 3D-surroundgeluid en het basniveau instellen.
1. Tik op de toets [Omhoog, Omlaag] in het menu 

DNSe menu om <User> (Gebruiker) te selecteren 
en tik op de toets [Rechts].

2. Tik op de toets [Omhoog, Omlaag] om <3D & 
BASS> (3D en bas) te selecteren en tik op [ ].

 Het instellingenscherm <3D & BASS> (3D en bas) 
wordt weergegeven.

3. Tik op de toets [Links, Rechts] om <3D> of <Bass> 
(Bas) te selecteren en tik op [Omhoog, Omlaag].

 U kunt voor <3D> en voor <Bass> (bas) een niveau 
selecteren van 0 tot 4.

4. Tik op [ ].
 De instelling is voltooid.
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De afspeelmodus instellen
De afspeelmodus selecteren, zoals de herhaalinstellingen.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Play 
Mode> (Afspeelmodus) te selecteren en tik op [ ].

 Het menu <Play Mode> (Afspeelmodus) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de gewenste 
afspeelmodus te selecteren en tik op [ ].

Opties voor afspeelmodus
Normal (Normaal) :  Alle nummers worden één keer in de normale volgorde 

afgespeeld.
Repeat (Herhaal) : Om alle bestanden in de huidige map te herhalen.
Repeat One (Eén herhalen) : Eén bestand wordt herhaald.
Shuffl e : Bestanden worden in willekeurige volgorde afgespeeld.
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
 Het muziekafspeelscherm selecteren
Kies een achtergrondafbeelding uit de geboden mogelijkheden of kies 
uw eigen achtergrondafbeelding. Deze wordt weergegeven terwijl u 
naar muziek luistert.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om <Music 

Play Screen> (Muziekafspeelscherm) te 
selecteren en tik op [ ].

 Het menu <Music Play Screen> 
(Muziekafspeelscherm) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om het 
gewenste muziekafspeelscherm te selecteren en 
tik op [ ].

Opties voor muziekafspeelscherm
Type 1 ~ Type 3 :  U kunt een muziekafspeelscherm naar keuze selecteren.
Album Info. (Albuminfo.) :  Informatie over de naam van de artiest, het 

album en het genre wordt weergegeven als ID3-
taginformatie is opgeslagen in het muziekbestand.

Album Art (Albumontw.) :  Een afbeelding van de cd-hoes wordt weergegeven als 
deze informatie is opgenomen in de ID3-taginformatie 
van het muziekbestand. Afbeeldingen van cd-hoesjes 
worden ondersteund als deze niet groter zijn dan 200 
pixels (horizontaal) x 200 pixels (verticaal).

Auto Change (Automatisch wijzigen) :  Hiermee wordt, iedere keer als er een 
ander muziekbestand wordt afgespeeld, 
automatisch geschakeld tussen <Type 
1> tot en met <Type 3>.

 Wat is een ID3-parameter? 
Dit is een tag in een MP3-bestand die informatie bevat over het bestand, 
zoals de titel, de artiest, het album, het jaar, het genre en een veld voor 
opmerkingen.

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Alarmgeluiden toevoegen
U kunt uw favoriete muziekbestanden toevoegen aan de lijst met 
wekkergeluiden, zodat u dit de volgende keer dat het alarm afgaat, 
hoort. Zie pagina 82 over het instellen van het alarm.
1. Selecteer een muziekbestand om toe te voegen 

aan de alarmgeluiden en tik op [ ].
Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Add to 
Alarm> (Bijvoegen aan Alarm) te selecteren en 
tik op [ ].

  De geselecteerde muziek wordt toegevoegd aan de lijst 
met alarmgeluiden.
 Er kan één muziekbestand worden toegevoegd als 
alarmgeluid.

De afspeelsnelheid instellen
U kunt de afspeelsnelheid van uw favoriete muziek versnellen of vertragen.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om <Play Speed> 

(Afspeelsnelheid) te selecteren en tik op [ ].
 Het menu <Play Speed> (Afspeelsnelheid) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de gewenste 
afspeelsnelheid te selecteren en tik op [ ].

   U kunt kiezen uit <X 0.7>, <X0.8>, <X 0.9>, 
<X 1.0(Normaal)>, <X 1.1>, <X 1.2> en <X 1.3>.  
  Hoe hoger het getal, des te sneller de afspeelsnelheid.

 Afhankelijk van het bestand kan de aangepaste snelheid afwijken van de 
ingestelde snelheid.OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Het interval voor overslaan instellen
U kunt snel vooruit door een bestand bladeren met verschillende 
intervallen. Sla een heel bestand over of meerdere seconden tegelijk.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Skip 
Interval> (Tijdverschuivingsinterval) te selecteren 
en tik op [ ].

 Het menu <Skip interval> (Tijdverschuivingsinterval) 
wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om het 
gewenste Tijdverschuivingsinterval te selecteren 
en tik op [ ].

 U kunt kiezen uit <1 Song>(1 nr.), <5sec>, <10sec>, <30sec> en <1min>.  

 Als het bestand is opgenomen met een variabele bitrate, komt het 
tijdverschuivingsinterval mogelijk niet precies overeen met wat u hebt 
ingesteld.

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Een bladwijzer instellen
Als u een bladwijzer instelt, kunt u deze plek later makkelijk terugvinden.
1. Tik op [ ] op het gewenste punt terwijl u naar 

muziek aan het luisteren bent.
Het muziekmenu wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Bookmark> 
(Bladwijzer) te selecteren en tik op [ ].

 Het menu <Music> (Muziek) wordt weergegeven.
3. Tik op de toets [Omhoog, Omlaag] om <Add 

Bookmark> (Bladwijzer toev.) te selecteren en tik 
op [ ].

 Het huidige afspeel-/stoppunt wordt aan de bladwijzer 
toegevoegd. 
 U ziet het symbool [ │ ] op de afspeelstatusbalk.

 Het venster Overschrijven verschijnt als er al eerder een bladwijzer 
is ingesteld. Als u <Yes> (Ja) selecteert, wordt de eerder ingestelde 
bladwijzer verwijderd en wordt er een nieuwe bladwijzer toegevoegd.
 U kunt één bladwijzer per muziekbestand instellen met een maximum van 
50 bladwijzers.

Naar de bladwijzer gaan (afspelen)/de bladwijzer verwijderen
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om <Bookmark> 

(Bladwijzer) te selecteren en tik op [ ].
 Het menu <Bookmark> (Bladwijzer) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <Go to 
Bookmark> (Ga naar bladwijzer) of <Delete 
Bookmark> (Bladwijzer verw.) te selecteren en 
tik vervolgens op [ ].

 Als u <Go to Bookmark> (Ga naar bladwijzer) hebt 
geselecteerd, gaat de speler naar de geselecteerde 
bladwijzer en wordt het afspelen gestart.
 Met <Delete Bookmark> (Bladwijzer verw.) verwijdert u de geselecteerde 
bladwijzer uit het muziekbestand.

OPMERKING
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een video bekijken
  Voordat u begint! - De koptelefoon aansluiten, de speler aanzetten en de batterij 
controleren. Een videobestand naar de speler overbrengen. 
De lijst met video's wordt weergegeven. Zie pagina 33~35.
 Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

1. Houd [ ] ingedrukt om naar het scherm met het 
hoofdmenu te gaan.

2. Tik op de toets [Links, Rechts] om <Videos> (Video’s) te 
selecteren en tik op [ ].

De lijst met video’s wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de video te 
selecteren die u wilt afspelen, en tik op [ ].

   Het geselecteerde videobestand wordt horizontaal afgespeeld.

PAUZEREN
1. Tik op [ ] terwijl een videobestand 

wordt afgespeeld.
Het afspelen wordt onderbroken.

2. Tik nogmaals op [ ].
Het afspelen wordt hervat vanaf het punt waarop het werd onderbroken.

  Wanneer u een videobestand naar de speler overbrengt met <EmoDio>, wordt het 
bestand vóór de overdracht geconverteerd naar de indeling SVI. Tevens wordt de 
bestandsgrootte aangepast.

OPMERKING

OPMERKING
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NAAR EEN SPECIFIEK FRAME GAAN
1. Houd in de horizontale weergave de toets [Links, 

Rechts] ingedrukt.
 Hierdoor kunt u in het huidige videobestand vooruit en 
achteruit spoelen.

2. Haal uw vinger van de toets nadat u naar de 
gewenste positie hebt gespoeld.

De video begint op dit punt af te spelen.

HET VORIGE VIDEOBESTAND AFSPELEN
Tik binnen 3 seconden nadat het huidige video 
bestand is begonnen met afspelen, op de toets 
[Links].
Tik 3 seconden nadat het huidige bestand is 
begonnen met afspelen, tweemaal op [Links].

De vorige video wordt nu afgespeeld.

HET VOLGENDE VIDEOBESTAND AFSPELEN
Tik op de toets [Rechts].

Het volgende bestand wordt nu afgespeeld. Video Track 2

Video Track 1

Video Track 1
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HET VIDEOMENU GEBRUIKEN
Een bladwijzer instellen
Als u een bladwijzer instelt, kunt u deze plek later makkelijk terugvinden.
1. Tik tijdens het afspelen van video op [ ] 

tijdens de gewenste scène.
Het menu <Video> wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Add Bookmark> (Bladwijzer toev.) te 
selecteren en tik op [ ].

 Het huidige afspeel-/stoppunt wordt aan de 
bladwijzer toegevoegd. 
 U ziet het symbool [ │ ] op de afspeelstatusbalk.

 Het venster Overschrijven verschijnt als er al eerder een bladwijzer is ingesteld. Als 
u <Yes> (Ja) selecteert, wordt de eerder ingestelde bladwijzer verwijderd en wordt 
er een nieuwe bladwijzer toegevoegd.
 U kunt één bladwijzer per videobestand instellen met een maximum van 50 
bladwijzers.

Naar de bladwijzer gaan (afspelen)/de bladwijzer verwijderen
1. Tik op [ ] terwijl een videobestand wordt 

afgespeeld.
Het menu <Video> wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Go to Bookmark> (Ga naar bladwijzer) 
of <Delete Bookmark> (Bladwijzer verw.) 
te selecteren en tik vervolgens op [ ].

 Als u <Go to Bookmark> (Ga naar bladwijzer) 
hebt geselecteerd, gaat de speler naar de 
geselecteerde bladwijzer en wordt het afspelen gestart.
 Met <Delete Bookmark> (Bladwijzer verw.) verwijdert u de geselecteerde 
bladwijzer uit het videobestand.

Tik op [ ] om het menu te verlaten.

OPMERKING
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HET VIDEOMENU GEBRUIKEN (Vervolg)
De Digital Natural Sound-engine (DNSe) instellen
De juiste geluidsweergave voor elk videogenre selecteren.
1. Tik op [ ] terwijl een videobestand wordt 

afgespeeld.
Het menu <Video> wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<DNSe> te selecteren en tik op [ ].

Het menu <DNSe> wordt weergegeven.
3. Tik op de toets [Omhoog, Omlaag] om de 

gewenste DNSe te selecteren en tik op [ ].
 U kunt kiezen uit <Normal> (Normaal), <Drama> en <Action> (Hand.).

 Wat is SVI?
Digital Natural Sound Engine (DNSe) is een functie voor geluidseffecten 
voor MP3-spelers die is ontwikkeld door Samsung. Dit biedt verschillende 
geluidsinstellingen voor het verbeteren van het type muziek waar u naar luistert.

De helderheid wijzigen
U kunt de helderheid van het scherm aanpassen.
1. Tik op [ ] terwijl een videobestand wordt 

afgespeeld.
Het menu <Video> wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Brightness> (Helderheid) te selecteren en 
tik op [ ].

 Het menu <Brightness> (Helderheid) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de helderheid aan te passen 
en tik op [ ].

U kunt kiezen uit <0~10>.

Add Bookmark
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afbeeldingen bekijken
 Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.
 Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

1. Houd [ ] ingedrukt om naar het scherm met het 
hoofdmenu te gaan.

2. Tik op de toets [Links, Rechts] om <Pictures> 
(Afbeeldingen) te selecteren en tik op [ ].

Het voorbeeldscherm voor afbeeldingen wordt weergegeven.

3. Tik op de [Links, Rechts, Omhoog, Omlaag] om de 
afbeelding te selecteren die u wilt weergeven, en tik op [ ].

De geselecteerde afbeelding wordt weergegeven.
Tik op [ ] om naar het vorige venster te gaan.

Naar de vorige/volgende 
afbeelding gaan
Tik in de horizontale 
weergave op de toets [Links, 
Rechts] ingedrukt.

 De vorige/volgende afbeelding 
wordt weergegeven.

  In  wordt een JPG-bestand 
weergegeven, inclusief onjuiste miniatuurweergavegegevens.
Sommige afbeeldingen worden langzamer weergegeven dan andere.
 Wanneer u een afbeelding naar de speler overbrengt met <EmoDio>, wordt het 
bestand vóór de overdracht geconverteerd naar JPG-indeling. Tevens wordt de 
bestandsgrootte aangepast.
 U kunt ook een afbeelding zoeken met behulp van de <File Browser> 
(Bestandsbrowser). Zie pagina 21.

OPMERKING

OPMERKING

Toets [Omhoog, Omlaag]

Toets [Links, Rechts]

<In horizontale weergave>



58 _ afbeeldingen bekijken
OPMERKING
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HET AFBEELDINGSMENU GEBRUIKEN
Naar muziek luisteren terwijl u een foto bekijkt.
U kunt naar het laatst afgespeelde nummer luisteren terwijl u een foto bekijkt.
1. Tik op [ ] terwijl u een foto bekijkt.

 Het menu <Picture> (Afbeeld.) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Music> (Muziek) te selecteren en tik op [ ].

 Het menu <Music> (Muziek) wordt weergegeven.  

3. Tik op de toets [Omhoog, Omlaag] om de 
gewenste modus te selecteren en tik op [ ].

 <Off> (UIT) : Er wordt geen achtergrondmuziek gespeeld terwijl u een foto bekijkt.
 <On> (AAN) :  U kunt naar het laatst afgespeelde nummer luisteren terwijl u 

een foto bekijkt.

Een diavoorstelling bekijken
Instructie 1
1. Tik op [ ] terwijl u een foto bekijkt.

 U ziet [ ] op het scherm en vervolgens wordt de 
diavoorstelling gestart.

Instructie 2
1. Tik op [ ] in de voorbeeldmodus voor afbeeldingen.

 Het scherm < Start Slideshow > (Diavertoning starten) 
wordt weergegeven.

2. Tik op [ ].
 U ziet [ ] op het scherm en vervolgens wordt de 
diavoorstelling gestart.

Tik op [ ] om het menu te verlaten.

Pictures 1/8

Picture Image 1

Start Slideshow
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
De diavoorstelling beëindigen

Instructie 1
1. Tik tijdens de diavoorstelling op [ ].

De diavoorstelling wordt gestopt.

Instructie 2
1. Tik tijdens de diavoorstelling op [ ].

 Het menu <Picture> (Afbeeld.) wordt 
weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Stop Slideshow> 
(Diavoorstelling stoppen) te selecteren en tik op [ ].

De diavoorstelling wordt gestopt.

De afspeelsnelheid van de diavoorstelling instellen
1. Tik op [ ] terwijl u een foto bekijkt.

Het afbeeldingsmenu wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Slideshow Speed> (Snelheid diavoorst.) 
te selecteren en tik op [ ].

 Het menu <Slideshow speed> (Snelheid 
diavoorst.) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de gewenste snelheid te 
selecteren en tik op [ ].

 U kunt kiezen uit <Fast> (Snel), <Normal> (Normaal) en <Slow> (Traag).

Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

Music
Stop Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
Een afbeelding vergroten
U kunt inzoomen op een afbeelding.
1. Tik op [ ] terwijl u een afbeelding bekijkt.

Het afbeeldingsmenu wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om 

<Zoom> te selecteren en tik op [ ].
Het menu <Zoom> wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de 
gewenste zoomfactor te selecteren en tik 
op [ ].

U kunt kiezen uit <100%>, <200%> en <400%>.
4. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om naar het 

gedeelte van de afbeelding te gaan waarop u wilt inzoomen.

Het zoomen annuleren

Tik op [ ] in de vergrootte weergave van een afbeelding.
 Hiermee keert u terug naar de normale afmeting.

Het kan iets langer duren om in te zoomen op een grote afbeelding.
OPMERKING

Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin
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Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
Een afbeelding draaien
U kunt een afbeelding desgewenst draaien.
1. Tik op [ ] terwijl u een afbeelding bekijkt.

Het menu <Picture> (Afbeeld.) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Rotate> (Draaien) te selecteren en tik op [ ].

 Het menu <Rotate> (Draaien) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de 
gewenste hoek te selecteren en tik op [ ].

 U kunt kiezen uit <Left 90°> (Links 90°), <Right 90°> (Rechts 90°) en <180°>. 

Een afbeelding als achtergrondafbeelding selecteren
U kunt een afbeelding naar keuze instellen als achtergrond voor het scherm.
1. Selecteer het afbeeldingsbestand dat u als 

achtergrondafbeelding wilt instellen en tik 
op [ ].

 Het menu <Picture> (Afbeeld.) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Select as My Skin> (Select. als Mijn 
huid) te selecteren en tik op [ ].

 Het bevestigingsvenster wordt weergegeven.

3. Tik op de toets [Links, Rechts] om <Yes> (Ja) te selecteren en tik 
op [ ].

De geselecteerde afbeelding wordt ingesteld als achtergrondafbeelding.
 Als <My Skin> (Mijn huid) is geselecteerd in <Settings> (Instellingen)→ 
<Menu Style> (Menustijl) → <Menu Design> (Menuontwerp), wordt de 
ingestelde afbeelding weergegeven.
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naar de FM-radio luisteren
  Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.
 Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

1. Houd [ ] ingedrukt om naar het scherm met het 
hoofdmenu te gaan.

2. Tik op de toets [Links, Rechts] om <FM Radio> (FM-
radio) te selecteren en tik op [ ]. 

FM-radio wordt ontvangen.

DE DEMPFUNCTIE GEBRUIKEN
1. Tik op [ ] tijdens het luisteren naar de FM-radio.

Het geluid wordt onderdrukt.

2. Tik nogmaals op [ ] om het geluid weer in te schakelen.

 Sluit altijd de oortelefoon aan op uw speler als u frequenties zoekt of instelt.
De oortelefoon wordt gebruikt als antenne voor het ontvangen van FM-radio.
In gebieden met slechte ontvangst worden mogelijk geen FM-stations gevonden.

OPMERKING

OPMERKING
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FM-STATIONS ZOEKEN
1. Activeer de handmatige modus en houd de toets [Links, 

Rechts] ingedrukt en laat deze vervolgens los.
 Het zoeken stopt bij de eerstvolgende frequentie nadat u de toets 
hebt losgelaten.

OF,

1. Tik op de toets [Links, Rechts] om in de handmatige 
modus stap voor stap door de frequenties te bladeren.

Wanneer u de toets indrukt wordt er naar een frequentie gezocht.

Searching

BBC R2
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HET MENU FM-RADIO GEBRUIKEN
Overschakelen naar de stand met voorinstellingen
Selecteer deze stand als u de opgeslagen FM-voorinstellingen wilt 
afzoeken.
1. Tik in de handmatige stand op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Go to Preset 
Mode> (Ga naar Preset Modus) te selecteren en tik op 
[ ].

<Preset> wordt op het scherm weergegeven.

 Als er vooraf geen frequenties zijn ingesteld, 
schakelt de speler niet naar de Preset mode 
(Voorinstellingsmodus).

Overschakelen naar de handmatige stand
Selecteer deze stand als u de FM-band handmatig per frequentie wilt 
afzoeken.
1. Tik in de stand met voorinstellingen op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Go 
to Manual Mode> (Ga naar Handm. Modus) te 
selecteren en tik op [ ].

<Manual> wordt op het scherm weergegeven.

OPMERKING

Go to Preset Mo..
Add to Preset
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Stations opslaan in het voorkeuzegeheugen
U kunt maximaal 30 stations opslaan in het geheugen van uw MP3-
speler en deze vervolgens met één druk op de knop oproepen. Laat de 
MP3-speler met het handmatige proces alleen de zenders kiezen die u 
wilt, of sla automatisch alle gevonden lokale zenders op. 
Manual (Handmatig) : alleen de stations kiezen die u wilt opslaan
1. Tik op de toets [Links, Rechts] om in de 

handmatige modus een frequentie te selecteren 
die u wilt instellen, en tik op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Add to 
Preset> (Toev. aan voorinst.) te selecteren en tik op 
[ ].

 De geselecteerde frequentie wordt aan de lijst met 
voorkeuzestations toegevoegd.

3. Als u andere frequenties wilt instellen, volgt u de stappen 1-3 hierboven.

 Als een bepaalde frequentie al is voorgeprogrammeerd, wordt de instelling 
geannuleerd.OPMERKING

Go to Preset Mo..
Add to Preset
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Stations opslaan in het voorkeuzegeheugen (Vervolg)
Automatisch : automatisch alle zenders opslaan die de speler 
ontvangt
1. Tik in de modus FM Radio op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Auto Preset> 
(Autom. voorinst.) te selecteren en tik op [ ].

Het bevestigingsvenster wordt weergegeven.

3. Tik op de toets [Links, Rechts] om <Yes> (Ja) te 
selecteren en tik op [ ].

 Er worden maximaal 30 frequenties automatisch 
ingesteld.

Automatische voorinstelling annuleren
Als u de automatische voorinstelling wilt annuleren, tikt u tijdens het 
proces op [ ].

 Het automatisch voorprogrammeren wordt geannuleerd en alleen de frequenties 
die tot op dat moment zijn ingesteld, worden opgeslagen.

 U kunt de opgeslagen stations opnieuw instellen als u de MP3-speler in 
een andere stad gaat gebruiken. Als u de opgeslagen stations wilt wissen 
en nieuwe wilt laten opslaan, hoeft u het proces slechts te herhalen.

OPMERKING

Go to Preset Mo..
Add to Preset
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)

Luisteren naar een voorkeuzestation
Tik in de voorinstellingsmodus op de toets [Links, 
Rechts] om door de voorgeprogrammeerde stations 
te bladeren.

 U kunt naar de opgeslagen radiofrequentie luisteren.

Een voorkeuzestation wissen
Volg de onderstaande stappen om frequenties te verwijderen terwijl u 
naar de radio luistert.
1. Tik in de voorinstellingsmodus op [Links, 

Rechts] om naar de voorgeprogrammeerde 
frequentie te zoeken die u wilt verwijderen, en tik 
vervolgens op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Delete 
from Preset> (Verw. uit voorpr.) te selecteren en 
tik op [ ].

De geselecteerde frequentie wordt verwijderd.

3. Als u andere voorgeprogrammeerde frequenties  wilt verwijderen, 
volgt u de stappen 1-2 hierboven.

Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

BBC R2
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Een FM-radio-uitzending opnemen
U kunt op elk gewenst moment een FM-radio-uitzending opnemen terwijl u 
naar de radio luistert.
1. Tik op de toets [Links, Rechts] om in de modus 

voor FM-radio een op te nemen frequentie te 
selecteren en tik op [ ].

 Het menu <FM Radio> (FM-radio) wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om <Start 

Recording> (Opname starten) te selecteren en 
tik op [ ].

 Er wordt een automatisch gemaakt bestand 
weergegeven en de opname start.

De opname beëindigen
1. Tik tijdens het opnemen op [ ].

 U wordt gevraagd of u het bestand dat u zojuist heeft 
opgenomen, wilt beluisteren.

2. Tik op de toets [Links, Rechts] om <Yes> (Ja) of 
<No> (Nee) te selecteren en tik op [ ].

 Als u <Yes> (Ja) kiest, wordt het zojuist opgenomen 
bestand afgespeeld.
  Als u <No> (Nee) kiest, wordt het zojuist opgenomen 
bestand niet afgespeeld.
 Het opgenomen bestand wordt opgeslagen in <File 
Browser> (Bestandsbrowser) → <Recorded Files> 
(Opgenomen Bestanden) → <FM Radio> (FM-radio).

 U kunt maximaal 999 bestanden met FM-radio-opnames opslaan. 
 U kunt ongeveer 30 uur opnamen maken (op basis van128 Kbps, 2GB).
 De bestandsnaam van de opname wordt automatisch samengesteld, 
bijvoorbeeld “FM_XXX.mp3”. “FM” geeft aan dat het bestand een FM-opname 
is en “XXX” is het bestandsnummer van de opname.

OPMERKING

Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
De kwaliteit van de FM-opname instellen
Hier kunt u de opnamekwaliteit voor FM-radio instellen.
1. Tik in de modus FM Radio op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om <FM 

REC Quality> (FM-opn. kwaliteit) te selecteren 
en tik op [ ].

 Het menu voor de kwaliteit van FM-opname wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de 
gewenste kwaliteit te selecteren en tik op [ ].

 Selecteer uit <Super High(192kbps)> (Superhoog 
(192kbps)), <High(160kbps)> (Hoog (160kbps)) en 
<Normal(128kbps)> (Normaal (128kbps)).
 Hoe hoger de waarde, des te hoger de geluidskwaliteit en des te groter het 
opgenomen bestand.

FM-ontvangst instellen
Met de instelling <FM Sensitivity> (FM Gevoeligheid) kunt u de 
ontvangstgevoeligheid instellen.
1. Tik in de modus FM Radio op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om <FM 

Sensitivity> (FM Gevoeligheid) te selecteren en tik op 
[ ].

 Het menu <FM Sensitivity> (FM Gevoeligheid) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om het 
zoekniveau te selecteren en tik op [ ].

  U kunt kiezen uit <High> (Hoog), <Middle> (Midden) 
en <Low> (Laag).
 Als u <High> (Hoog) selecteert, worden meer frequenties ontvangen.

Tik op [ ] om het menu te verlaten.

Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

OPMERKING
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Een FM-regio instellen
U kunt een FM-regio instellen voor reizen naar het buitenland.
1. Tik in de modus FM Radio op [ ].

 Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <FM 
Region> (FM-regio) te selecteren en tik op [ ].

 Het menu <FM Region> (FM-regio) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om uw regio 
voor FM-radio te selecteren en tik op [ ].

 U kunt kiezen uit <Korea/US> (Korea/VS), <Japan> en 
<Other Countries> (Andere Landen).

 Opgeslagen radiofrequenties worden gewist wanneer u de instelling <FM 
Region> (FM-regio) op de speler wijzigt.

 De FM-regio kan worden verwijderd of gewijzigd overeenkomstig de 
doelregio voor de speler. 

 Frequentiebereik naar regio
-  Korea/US (Korea/VS) : FM-frequenties in 100 kHz-spelers zoeken tussen 87.5 

MHz~108.0 MHz.
-  Japan : FM-frequenties in 100 kHz-spelers zoeken tussen 76.0 MHz~108.0 

MHz.
-  Other Countries (Andere Landen) : FM-frequenties in 50 kHz-spelers zoeken 

tussen 87.50 MHz~108.00 MHz.

OPMERKING

Go to Manual M..
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Het RDS-display instellen
RDS (Radio Data System (Radiogegevenssysteem)) verzorgt de 
ontvangst en weergave van berichten zoals uitzendinformatie. 
De programmagegevens zoals nieuws, sport of muziek, of informatie 
over het zendstation worden weergegeven op het display.
1. Tik in de modus FM Radio op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <RDS 
Display> te selecteren en tik op [ ].

Het menu <RDS Display> wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de modus 
RDS-display te selecteren en tik op [ ].

 U kunt kiezen uit <Program Service> 
(Programmaservice) en <Program Type> 
(Programmatype).

Opties RDS Display
Program Service (Programmaservice) : Geeft de naam van het zendstation 
weer en bestaat uit 8 tekens. Als de PS-gegevens worden ontvangen, wordt de 
PS-naam (BBC, AFO, NDR etc.) weergegeven op het display. 
Als de PS-gegevens niet worden ontvangen, wordt de originele FM-frequentie 
weergegeven.
Program Type (Programmatype) : Geeft het huidig uitgezonden type 
programma weer.

 Als het FM-signaal zwak is, worden de RDS-gegevens mogelijk niet 
weergegeven.OPMERKING

Delete from Pre..
Auto Preset
Start Recording
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)

Alarmgeluiden toevoegen
U kunt de FM-radio toevoegen aan de lijst met alarmgeluiden, zodat u 
de radio hoort als het alarm afgaat. Zie pagina 82 over het instellen van 
het alarm.
1. Selecteer een radiofrequentie om toe te voegen 

aan de alarmgeluiden en tik op [ ].
  Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Add to 
Alarm> (Bijvoegen aan Alarm) te selecteren en tik 
op [ ].

 Als u het alarmgeluid instelt op <FM Radio> (FM-
radio) in de alarminstellingen, kunt u naar de FM-radio 
luisteren.

Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
RDS Display 
Add to Alarm
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de datacast gebruiken
Met <EmoDio> kunt u RSS-bloginformatie en -bestanden naar de speler 
overbrengen.

 Wat is RSS?
RSS staat voor Rich Site Summary of Really Simple Syndication. RSS is een op XML 
gebaseerd systeem voor gegevensoverdracht dat wordt gebruikt om eenvoudiger informatie 
weer te geven op websites die vaak worden bijgewerkt, zoals nieuwssites en blogs.
  Wat zijn datacasts?
U kunt automatisch bijgewerkte informatie ontvangen zonder telkens naar uw veelbezochte 
nieuws-, blog- en UCC-sites te hoeven gaan.
Voordat u begint! -  EmoDio moet zijn geïnstalleerd op de computer. Zie pagina 32.

EEN KANAAL REGISTREREN
U kunt een nieuw kanaal maken door websites of webpagina’s met RSS-
ondersteuning te registreren.
1. Klik op <Subscribe> (Aanmelden) onder 

aan het gedeelte <Datacasts> van 
<EmoDio>.

2. Voer een adres in bij <URL> en klik op 
<►Next> (►Volgende).

 Als u een webadres kopieert en op <Subscribe> 
(Aanmelden) klikt, wordt het gekopieerde adres 
automatisch weergegeven bij <URL>.
 Het venster voor bevestiging van de 
instellingen wordt weergegeven als het 
webadres ondersteuning biedt voor RSS.

3. Klik op <OK>.
Het gewenste kanaal is geregistreerd.
Het pictogram  wordt weergegeven in Datacasts voor het geregistreerde kanaal.

Zie <Datacasts> van <EmoDio> voor meer informatie.

OPMERKING

OPMERKING
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2
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EEN NIEUWE KANAALGROEP MAKEN
U kunt een nieuwe groep maken om kanalen per categorie te beheren.
1. Klik op <New Group> (Nieuwe groep) onder 

aan het gedeelte <Datacasts> van <EmoDio>.
2. Typ een groepsnaam en beschrijving en klik op 

<OK>.

EEN DATACAST OVERBRENGEN 
VAN <EMODIO>

Voordat u begint! -  Sluit de speler aan op de computer. EmoDio moet zijn 
geïnstalleerd op de computer. Zie pagina 32.

1. <EmoDio> wordt automatisch gestart op het 
moment dat de speler wordt aangesloten op de 
computer.

 Als het programma niet automatisch wordt gestart, 
dubbelklikt u op het pictogram  van <EmoDio> 
op het bureaublad.

2. Klik op <Datacasts> boven in<EmoDio>.
 De lijst met groepskanalen voor Datacasts wordt 
weergegeven.

3. Klik op het gewenste groepskanaal.
4. Klik op het gewenste kanaal.
5. Selecteer de melding dat u wilt overbrengen.
6. Klik op het pictogram .

 De melding van het geselecteerde kanaal wordt overgebracht naar de speler in <File 
Browser> (Bestandsbrowser) → <Datacasts>.

Klik op  boven in <EmoDio> om naar het vorige scherm te gaan.
 Als het bericht een bijlage bevat, kunt u in <Datacasts> in <EmoDio> de bijlage 
downloaden naar de speler. Het kan echter zijn dat de bijlage niet gedownload kan 
worden, afhankelijk van het beleid van de betreffende website.

OPMERKING
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DATACASTS WEERGEVEN
U kunt aan <Datacasts> toegevoegde kanaalberichten weergeven.

 Voordat u begint! - Breng de gewenste kanaalberichten over naar de speler via 
<EmoDio>. Zie pagina 74.
 Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

1. Houd [ ] ingedrukt om naar het scherm met het 
hoofdmenu te gaan.

2. Tik op de toets [Links, Rechts] om <Datacasts> te 
selecteren en tik vervolgens op [ ].

De lijst met datacasts wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de gewenste 
kanaallijst te selecteren en tik op [ ].

  De titel is hetzelfde als die van het kanaal dat is toegevoegd aan 
<Datacasts> in <EmoDio>.

4. Tik op de toets [Omhoog, Omlaag] om de gewenste 
berichttitel te selecteren en tik op [ ].

  De lijst met bestanden wordt weergegeven.

pictogram  : Hoofdtekst van het overgebrachte bericht
pictogram : Afbeeldingsbestand
pictogram  : Muziekbestand
pictogram : Videobestand

5. Tik op de toets [Omhoog, Omlaag] om het gewenste 
bestand te selecteren en tik op [ ].

Het geselecteerde bestand wordt afgespeeld.

OPMERKING

Datacast 1
Datacast 2
Datacast 3
Datacast 4

Datacasts 1/4
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de extra functies gebruiken
Met Prime Pack kunt u meerdere functies gebruiken, bijvoorbeeld voor 
het lezen van tekst, spelletjes spelen en het instellen van het alarm.

TEKST LEZEN
Of het nou gaat om een roman, het manuscript van een nieuw verhaal of uw scriptie; u 
kunt het lezen op uw MP3-speler... met uw favoriete muziek op de achtergrond!

 Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij 
controleren. Breng tekstbestanden over naar de speler via <EmoDio>. Zie pagina 33.
Stel een voorkeurstaal voor tekst in via <Settings> (Instellingen) → <Language> 
(Taal) → <Contents> (Inhoud). Zie pagina 26.
  Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

1. Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.
2. Tik op de toets [Links, Rechts] om <Prime Pack> (Hoofdpakket) 

te selecteren en tik op [ ].
De <Prime Pack> (Hoofdpakket)-lijst wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <Text> (Tekst) te 
selecteren en tik op [ ].

De lijst met tekstbestanden wordt weergegeven.
4. Tik op de toets [Omhoog, Omlaag] om het gewenste 

tekstbestand te selecteren en tik op [ ].
De tekst wordt op het scherm weergegeven.

Naar de vorige/volgende pagina gaan
Tik op de toets [Links, Rechts].

 Houd de toets [Links, Rechts] iets langer ingedrukt om door de vorige of 
volgende pagina’s te bladeren.

 U kunt ook een tekstbestand zoeken met behulp van de <File Browser> 
(Bestandsbrowser). Zie pagina 21.
Uw MP3-speler ondersteunt de bestandsindeling TXT in de tekstmodus.
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HET TEKSTMENU GEBRUIKEN
Naar muziek luisteren terwijl u uw tekst bekijkt
U kunt naar het laatst afgespeelde nummer luisteren terwijl u uw tekst bekijkt.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Music> 
(Muziek) te selecteren en tik op [ ].

Het menu <Music> (Muziek) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de 
gewenste modus te selecteren en tik op [ ].

 <Off> (UIT) :  Er wordt geen achtergrondmuziek 
gespeeld terwijl u de tekst bekijkt.

 <On> (AAN) :  U kunt naar het laatst afgespeelde nummer luisteren terwijl u 
de tekst bekijkt.

Naar de eerste pagina gaan
Gebruik deze optie als u de tekst van de eerste pagina wilt bekijken.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Go to 
1st Page> (Ga naar 1e Pagina) te selecteren en 
tik op [ ].

  Er wordt een venster weergegeven met daarin de 
bevestiging dat u naar de eerste pagina gaat.

3. Tik op de toets [Links, Rechts] om <Yes> (Ja) te 
selecteren en tik op [ ].

  U gaat naar de eerste pagina.
Tik op [ ] om het menu te verlaten.
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HET TEKSTMENU GEBRUIKEN (Vervolg)
Een bladwijzer instellen
Stel een bladwijzer in om een volgende keer terug te gaan naar een 
bepaald punt in de tekst.
1. Tik tijdens het lezen van een tekst op de 

gewenste pagina op [ ].
Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Add 
Bookmark> (Bladwijzer toev.) te selecteren en 
tik op [ ].

  In het huidige tekstscherm wordt een bladwijzer 
ingesteld en het symbool [ ] wordt linksboven in het 
scherm weergegeven.

 Het venster Overschrijven verschijnt als er al eerder een 
bladwijzer is ingesteld. Als u <Yes> (Ja) selecteert, wordt de eerder ingestelde 
bladwijzer verwijderd en wordt er een nieuwe bladwijzer toegevoegd.
 U kunt één bladwijzer per tekstbestand instellen met een maximum van 50 
bladwijzers.

Naar de bladwijzer gaan/de bladwijzer verwijderen
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Go to 
Bookmark> (Ga naar bladwijzer) of <Delete 
Bookmark> (Bladwijzer verw.) te selecteren en 
tik vervolgens op [ ].

 Als u <Go to Bookmark> (Ga naar bladwijzer) 
selecteert, gaat u naar de geselecteerde bladwijzer. 
Met <Delete Bookmark> (Bladwijzer verw.) verwijdert 
u de geselecteerde bladwijzer uit het tekstbestand.
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ET TEKSTMENU GEBRUIKEN (Vervolg)
De lettergrootte wijzigen
U kunt de lettergrootte van de tekst wijzigen.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Font 
Size> (Lettergr.) te selecteren en tik op [ ].

Het menu <Font Size> (Lettergr.) wordt weergegeven.

3. Tik op de toets [Links, Rechts] om de gewenste 
tekengrootte te selecteren en tik vervolgens op [ ].

 U kunt kiezen ui <Small> (Klein), <Medium> en 
<Large> (Groot).

De kleur van de tekstviewer instellen
Kies in welke kleur u de tekst wilt weergeven.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Text Viewer 
Color> (Kleur tekstviewer) te selecteren en tik op [ ].

 Het menuvenster <Text Viewer Color>(Kleur 
tekstviewer) wordt weergegeven.

3. Tik op de toets [Links, Rechts] om de gewenste 
kleur voor de tekstviewer te selecteren en tik 
vervolgens op [ ].

 U kunt kiezen uit <Type 1> tot en met <Type 6>.
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VIDEOSPELLETJES SPELEN
Op uw mp3-speler staan al spannende spelletjes!

 Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.
 Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

1. Houd [ ] ingedrukt om naar het scherm met het 
hoofdmenu te gaan.

2. Tik op de toets [Links, Rechts] om <Prime Pack> 
(Hoofdpakket) te selecteren en tik op [ ].

De <Prime Pack> (Hoofdpakket)-lijst wordt weergegeven.
3. Tik op de toets [Omhoog, Omlaag] om <Games> (Spel) te 

selecteren en tik op [ ].
De lijst met spelletjes wordt weergegeven.

4. Tik op de toets [Omhoog, Omlaag] om het gewenste spel 
te selecteren en tik op [ ].

Baseball
Probeer te scoren tegen één van de beste pitchers 
van de divisie, in deze versie van het favoriete 
tijdverdrijf van de Amerikanen.
Tik op de toets [Omhoog, Omlaag, Links, Rechts] om 
een menu of functie te selecteren.
Druk op de toets [ ] om de bal te werpen of te slaan.

Pizza Delivery
Probeer de pizza op tijd te leveren en vermijd de 
vele obstakels onderweg.
Druk op [ ] om omhoog te springen.

OPMERKING
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VIDEOSPELLETJES SPELEN (Vervolg)
Honeybee
Dit is een puzzelspelletje waarin u punten verzamelt 
wanneer u meer dan drie blokken vindt die bij elkaar passen.
Tik op de toets [Omhoog, Omlaag, Links, Rechts] 
om een menu te selecteren of de richting van het 
object te wijzigen.
Druk op [ ] om te selecteren of te annuleren.

Jungmumun
Bij dit spel hebt u een goed reactievermogen nodig. 
U moet de steen verplaatsen in de richting van de pijl 
waarmee de steen gemarkeerd is.
Gebruik de toetsen [Omhoog, Omlaag, Links, 
Rechts] en [ ] om de steen te verwijderen.

Food King
Dit is een hersenkraker waarbij u zoveel mogelijk 
voedsel moet bereiden. Dit doet u door de volgorde 
van drie blokken te wijzigen, zodat deze overeenkomt 
met drie richtingen - in de breedte, lengte en 
diagonaal.
Gebruik de toets [Links, Rechts] om het object te 
verplaatsen.
Gebruik de toets [Omhoog] om de positie van het 
object te wijzigen.
Tik op de toets [Omlaag] om het object te laten vallen.

 Spelletjes kunnen zonder voorafgaand bericht worden toegevoegd of gewijzigd.
 Zie de Help-informatie voor meer informatie over het spelen van het spel.

OPMERKING
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HET ALARM INSTELLEN
Deze speler heeft een alarm dat  u zo kunt instellen, dat deze afgaat op een 
gepland tijdstip.

Voordat u begint! -  De huidige datum en tijd instellen. Zie pagina 27.

1. Houd [ ] ingedrukt om naar het scherm met het 
hoofdmenu te gaan.

2. Tik op de toets [Links, Rechts] om <Prime Pack> 
(Hoofdpakket) te selecteren en tik op [ ].

De <Prime Pack> (Hoofdpakket)-lijst wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <Alarm> te 
selecteren en tik op [ ].

4. Tik op de toets [Omhoog, Omlaag] om <New Alarm> 
(Nieuw alarm) te selecteren en tik op [ ].

 Het scherm <New Alarm Settings> (Nieuwe alarminst.) wordt 
weergegeven.

5. Tik op de toets [Omhoog, Omlaag] om een 
alarmfrequentie te selecteren en tik op de toets [Rechts].

 U kunt kiezen uit <Once> (Eenmalig), <Everyday> (Elke dag), 
<Mon~Fri> (Maan-Vrijd), <Mon~Sat> (Maan-Zat), <Sat~Sun> 
(Zat-Zon) en <Off> (UIT).

6. Tik op de toets [Omhoog, Omlaag] om het gewenste 
uur te selecteren en tik op de toets [Rechts].

7. Tik op de toets [Omhoog, Omlaag] om de gewenste minuut te selecteren 
en tik op de toets [Rechts].

8. Tik op de toets [Omhoog, Omlaag] om <AM> of <PM> te selecteren en tik 
op de toets [Rechts].
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HET ALARM INSTELLEN (Vervolg)
9. Tik op de toets [Omhoog, Omlaag] om een alarmgeluid 

te selecteren en tik op de toets [Rechts].
 Kies uit <Alarm Sound 1> (Alarmgeluid 1) tot en met <Alarm 
Sound 3> (Alarmgeluid 3), een muziekbestand dat is 
toegevoegd aan de alarmgeluiden of FM-radio.

10. Tik op de toets [Omhoog, Omlaag] om een alarminterval te 
selecteren en tik op [ ].

 U kunt kiezen uit <Interval : Off> (Interval uit), <Interval : 3min> 
(Interval: 3min), <Interval : 5min> (Interval: 5min) en <Interval: 
10min> (Interval: 10min).
Het bevestigingsvenster voor opslaan wordt weergegeven.

11. Tik op de toets [Links, Rechts] om <Yes> (Ja) te selecteren en tik op [ ].
 Als het instellen van het alarm is voltooid, wordt het symbool ( ) bovenaan 
weergegeven.

U kunt maximaal 7 alarmen instellen.
 Het alarm gaat op de ingestelde tijd af. Tik op [ ] om het alarm te stoppen.
Wanneer het bevestigingsvenster wordt weergegeven, tikt u op de toets [Links, 
Rechts] om <Yes> (Ja) te selecteren en tikt u vervolgens op [ ]. Hiermee verlaat u 
de alarmgegevens en keert u terug naar het hoofdmenu.

OPMERKING
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HET ALARM INSTELLEN (Vervolg)
De alarminstelling bewerken
1. Tik op [Omhoog, Omlaag] om in de alarmlijst de 

alarminstelling te selecteren die u wilt wijzigen, 
en tik vervolgens op [ ].

 Het scherm < Alarm Settings > (Alarminst.) wordt 
weergegeven.

2. Gebruik de toetsen [Omhoog, Omlaag, Links, 
Rechts] en [ ] om de gewenste instellingen te 
wijzigen.

Een alarminstelling verwijderen
1. Tik op [Omhoog, Omlaag] om in de alarmlijst 

de alarminstellingen te selecteren die u wilt 
verwijderen, en tik vervolgens op [ ].

Het menu voor verwijderen wordt weergegeven.

2. Tik op [ ].
Het scherm < Delete > (Wissen) wordt weergegeven.

3. Tik op de toets [Links, Rechts] om <Yes> (Ja) te 
selecteren en tik op [ ].

Het geselecteerde alarm wordt verwijderd.
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DE WERELDKLOK WEERGEVEN
U kunt de locatie en datum/tijd van grote wereldsteden bekijken op basis van de 
respectievelijke tijdzone.

 Voordat u begint! - De huidige datum en tijd instellen. Zie pagina 27.
Stel de gewenste tijdzone in via <Settings> (Instellingen) → <Time> (Tijd) → 
<Time Zone> (Tijdszone).

1. Houd [ ] ingedrukt om naar het scherm met het 
hoofdmenu te gaan.

2. Tik op de toets [Links, Rechts] om <Prime Pack> 
(Hoofdpakket) te selecteren en tik op [ ].

De <Prime Pack> (Hoofdpakket)-lijst wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <World Clock> 
(Wereldklok) te selecteren en tik op [ ].
Het scherm <World Clock> (Wereldklok) wordt weergegeven.

4. Tik op de toets [Links, Rechts] om een tijdzone te 
selecteren.

U kunt de lokale tijd van de volgende tijdzones bekijken. 
(‘/’ geeft de standaard tijdzone in de regio weer)
Cape Verde / London, Lisbon / Rome, Paris, Berlin, Stockholm, Madrid, Frankfurt/ 
Athens, Helsinki, Cairo, Ankara / Moscow, Riyadh / Abu Dhabi, Muscat / Tashkent, Ashgabat /
Alma Ata, Kathmandu / Bangkok, Jakarta, Rangoon / Hongkong, Beijing, Manila, Singapore / 
Seoul, Tokyo, Pyongyang / Guam, Sydney, Brisbane / Okhotsk / 
Wellingtons, Oakland, Fiji / Samoa, Midway / Honolulu, Hawaii, Tahiti / Alyeska / 
Los Angeles, San Francisco, Vancouver, Seattle / Denver, Phoenix, Salt Lake City / 
Chicago, Dallas, Houston, Mexico City / New York, Miami, Washington DC, Montreal, Atlanta / 
Caracas, LA Paz, Santiago / Buenos Aires, Brasilia, Sao Paulo / The middle Atlantic 
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problemen oplossen
Als u problemen ondervindt met uw nieuwe MP3-speler, vindt 
u mogelijk een oplossing in deze lijst. Als het probleem zich blijft 
voordoen, kunt u contact opnemen met het dichtstbijzijnde Samsung 
Customer Service Center.

PROBLEEM OPLOSSING

Kan de speler niet 
inschakelen.

• De speler kan niet worden ingeschakeld als de 
batterij helemaal leeg is. Laad de batterij op en 
schakel de speler nogmaals in.

• Druk met een scherp voorwerp de 
resetopening in.

De toetsen werken niet.

• Controleer of de schakelaar  in de 
richting van de pijl is geduwd.

•  Controleer of u op de juiste toets hebt gedrukt, 
en druk nogmaals op de toets.

• Druk met een scherp voorwerp de 
resetopening in.

Het scherm wordt niet 
ingeschakeld.

• Het scherm is in vol zonlicht mogelijk niet goed 
zichtbaar.

• Als <Display Off> (Display Uit) is geselecteerd 
in <Settings> (Instellingen) → <Display> 
(Weergave), wordt het scherm uitgeschakeld.
Tik op een willekeurige toets om te zien of het 
wordt ingeschakeld.
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PROBLEEM OPLOSSING

De speler wordt 
uitgeschakeld.

• Controleer de batterijstatus.
• De speler wordt automatisch uitgeschakeld 

wanneer de batterij helemaal leeg is. Laad de 
batterij op.

• Als u <Auto Power Off> (Autom. uitschakelen) 
selecteert via <Settings> (Instellingen) → 
<System> (Systeem), zal de speler in de 
pauzestand worden uitgeschakeld. Schakel de 
speler in.

De levensduur van 
de batterij verschilt 
met de levensduur die 
is aangegeven in de 
gebruiksaanwijzing.

• Hoelang de batterij meegaat kan variëren, 
afhankelijk van de geluids- en scherminstellingen.

• Wanneer de speler langdurig wordt blootgesteld 
aan lage of hoge temperaturen, kan dit ten koste 
gaan van de levensduur van de batterij.

Storingen in de werking 
van EmoDio

• Controleer of uw computer voldoet aan de 
minimum systeemvereisten.

Kan geen verbinding 
met de computer 
maken.

• Controleer of de USB-kabel juist is aangesloten 
en probeer het nogmaals.

• Klik op <Start> op het bureaublad van de 
computer om Windows Update uit te voeren. 
Selecteer Essentiële updates en Service packs 
en installeer alle updates. Start de computer 
opnieuw op en sluit de speler opnieuw aan.

De overdrachtssnelheid 
van bestanden is te 
laag.

• De overdrachtssnelheid is lager als u meerdere 
programma’s, waaronder <EmoDio>, op uw 
computer uitvoert. Sluit overbodige programma’s af 
en probeer het nog eens.



88 _ problemen oplossen

PROBLEEM OPLOSSING

De speler speelt niet af

• Controleer of het beschikbare bestand is 
opgeslagen in het geheugen.

• Controleer of het muziekbestand is beschadigd.
• Controleer of de batterij voldoende is opgeladen.

Het uploaden van 
bestanden werkt niet.

• Controleer of de USB-kabel goed is 
aangesloten. Sluit deze zonodig opnieuw aan.

• Controleer of het geheugen vol is.
• Druk met een scherp voorwerp de resetopening in.

Er ontbreken bestanden 
of gegevens.

• Controleer of de USB-kabel is losgeraakt tijdens 
de bestandsoverdracht. Dit kan overigens niet 
alleen leiden tot ernstige beschadiging van de 
bestanden/gegevens, maar ook van het product. 
Let goed op, want Samsung is niet aansprakelijk 
voor gegevensverlies.

Abnormale afspeeltijd 
tijdens het afspelen.

• Controleer of het bestand een VBR-indeling 
(Variable Bit Rate) heeft.

Abnormale weergave 
van bestandsnaam.

• Ga naar <Settings> (Instellingen) → 
<Language> (Taal) → <Contents> (Inhoud) in 
het hoofdmenu om de juiste taal in te stellen.

Het product wordt 
warm.

• Er komt tijdens het opladen wat warmte vrij. Dit 
heeft geen invloed op de levensduur of functies 
van het product.

Er wordt een melding 
weergegeven tijdens 
het bekijken van een 
video.

• Probeer de videoclip nogmaals te downloaden 
met EmoDio.
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bijlage
OVERZICHT VAN MENUOPTIES
Hier vindt u een overzicht van de structuur van de menu’s en functies op uw 
nieuwe MP3-speler.

Het selectievenster Menu

Music Videos Pictures FM Radio Datacasts Prime Pack File Browser Settings

Text Menu 
Style

Games Sound

Alarm Display

World Clock Language

Time

System
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PRODUCTSPECIFICATIES
Model YP-S3
Classifi catie DC 5.0V / 500mA
Vermogen ingebouwde batterij 580 mAh/ DC 3.7V
Bestand Compatibiliteit AUDIO :  MPEG1/2/2.5 Layer3 (8 kbps - 320 kbps, 

8 kHz - 48 kHz), WMA (48 kbps - 192 
kbps, 8 kHz - 48 kHz)

VIDEO :  SVI (video : MPEG4, audio : MP3 (44,1 
kHZ, 128 kbps), resolutie : 208 X 176, 
framerate : 15 fps) 

BEELD :  JPG (Progressive, Sequential Scanning, 
bestandsformaat: minder dan 3 MB)

Maximaal aantal bestanden max. 5000 (incl. mappen)
Uitgangsvermogen oortelefoon 20mW/kan. (Frankrijk 5mW/kan.) (op basis van 16Ω)
Frequentiebereik 40 Hz - 20 kHz
Signaal/ruisverhouding 90 dB bij 20 kHz LPF (gebaseerd op 1kHz 0 dB)
Afspeelduur  maximaal 25 uur muziek afspelen, maximaal 4 uur 

video afspelen 
(op basis van MP3 128 kbps, volume : 15, 
normale modus)

Temperatuurbereik voor gebruik -5~35°C (23~95°F)
Houder Metaal en plastic
Gewicht 53 gram
Afmetingen (BxHxD) 44 x 95 x 9.8 mm

FM Radio FM-frequentie 87.5~108.0MHz Totale harmonische 
vervorming FM 1%

Signaal-
ruisverhouding FM 55 dB Gevoeligheid 

FM 38dBμ

De inhoud van deze gebruiksaanwijzing kan ter verbetering zonder 
voorafgaande kennisgeving worden gewijzigd.
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LICENTIE
Op dit apparaat en de gebruiksaanwijzing rusten intellectuele eigendomsrechten 
en auteursrechten van derden. Het gebruiksrecht van de gelicentieerde inhoud 
is beperkt tot niet-commercieel gebruik door eindgebruikers. Commercieel 
gebruik hiervan is niet toegestaan. Het gebruiksrecht beperkt zich tot dit 
apparaat en strekt zich niet uit tot andere niet-gelicentieerde onderdelen 
of processen die voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3 en die 
in combinatie met dit product gebruikt of verkocht zijn. De licentie beperkt 
zich tot het gebruik van dit product voor het encoderen en/of decoderen van 
geluidsbestanden die voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3. 
Deze licentie houdt geen overdracht van rechten in voor producteigenschappen 
of -functies die niet voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3.

CORRECTE VERWIJDERING VAN DIT PRODUCT 
(ELEKTRISCHE & ELEKTRONISCHE AFVALAPPARATUUR)
Dit merkteken op het product of het bijbehorende 
informatiemateriaal duidt erop dat het niet met ander 
huishoudelijk afval verwijderd mag worden aan het einde 
van zijn gebruiksduur. Om mogelijke schade aan het 
milieu of de menselijke gezondheid door ongecontroleerde 
afvalverwijdering te voorkomen, moet u dit product van 
andere soorten afval scheiden en op een verantwoorde 
manier recyclen, zodat het duurzame hergebruik van 
materiaalbronnen wordt bevorderd.
Huishoudelijke gebruikers moeten contact opnemen met 
de winkel waar ze dit product hebben gekocht of met de 
gemeente waar ze wonen om te vernemen waar en hoe ze 
dit product milieuvriendelijk kunnen laten recyclen.
Zakelijke gebruikers moeten contact opnemen met hun leverancier en de 
algemene voorwaarden van de koopovereenkomsten nalezen. Dit product mag 
niet worden gemengd met ander bedrijfsafval voor verwijdering.
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CORRECTE BEHANDELING VAN EEN GEBRUIKTE 
ACCU UIT DIT PRODUCT
(Van toepassing op de Europese Unie en andere Europese landen met 
afzonderlijke inzamelingssystemen voor accu’s en batterijen.)
Dit merkteken op de accu, handleiding of verpakking 
geeft aan dat de accu in dit product aan het einde van de 
levensduur niet samen met ander huishoudelijk afval mag 
worden weggegooid. De chemische symbolen Hg, Cd of 
Pb geven aan dat het kwik-, cadmium- of loodgehalte in 
de accu hoger is dan de referentieniveaus in de Richtlijn 
2006/66/EC. Indien de gebruikte accu niet op de juiste wijze 
wordt behandeld, kunnen deze stoffen schadelijk zijn voor 
de gezondheid van mensen of het milieu.  
Ter bescherming van de natuurlijke hulpbronnen en ter bevordering van het 
hergebruik van materialen, verzoeken wij u afgedankte accu’s en batterijen te 
scheiden van andere soorten afval en voor recycling aan te bieden bij het gratis 
inzamelingssysteem voor accu’s en batterijen in uw omgeving.



Wanneer u suggesties of vragen heeft met betrekking tot Samsung producten,
gelieve contact op te nemen met de klantenservice van Samsung

Samsung Electronics Benelux BV
Voor Nederland:

0900-SAMSUNG (726-7864 € 0,10/Min)
www.samsung.com/nl

Voor België: 
02 201 24 18

www.samsung.com/be
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